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Introduction

PicturesToExe Deluxe is the program, which can help you to create splendid slide shows,
consisting of almost limitless number of pictures in EXE file or SCR format (screensaver). The
interface of PicturesToExe Deluxe is very easy in use, both amateur PC users and professional
photographers and people of all specialities can work in this program without any difficulties.

PicturesToExe Deluxe supports different formats such as PNG, GIF, BMP and JPG, which is the
main for this program. A slideshow in EXE format can be reproduced on any computer under
Windows XP, Vista, 98, Me, 2000, 2003. No additional program (not even PicturesToExe itself) is
needed to run a finished slide show, except a produced EXE file.

You can place any objects (images, text labels with drop shadows) on a slide and customize
complex animation. It's either possible to use various cinematographic transition effects between
slides, to add background music, sound and text comments to a slide. You can also synchronize
slide shows to music. Slide show has very high picture quality and the smoothest playback of
Pan/Zoom effects you have ever seen.

VideoBuilder in PicturesToExe Deluxe edition allows you to burn a DVD video disc with your
slide shows quickly and easily. You can adjust the menu and many other parameters of your DVD
disc. You cannot but notice one more advantage, PicturesToExe gives you an opportunity to
create an AVI video file. If you think, it's necessary you can protect your slide show with a
password and assign an expiration date. Burned in PicturesToExe DVD video disc can be played
on any DVD player, PC or MAC.



Main features

s PicturesToExe produces a single EXE file which contains all pictures and music.

s PicturesToExe Deluxe can burn a DVD-Video disc with slide shows.

s Pan/Zoom/Rotate effects for images.

s A powerful slide object editor with the possibility for adjusting complex animations.
s You can add buttons or text labels with drop shadows and glows to a slide.

s Cinematographic transition effects between slides.

s The slides can be exactly synchronized to music on the timeline with a waveform.

s Slide show has a built-in player for high quality MP3 and OGG playback. It also supports
WMA, WAV and MIDI music playback.

a Ability to create a screensaver.

s Navigation bar in the slide show.

s An easy solution allowing creation of greeting cards.

s Ability to create AVI video file.

s Supports a multi-select and visual drag-n-drop between the file panel and the slide list.
s Supports sound comments for the slides (MP3, OGG, WMA or WAV).

s Images can be in JPEG, PNG, GIF or BMP format.

s Ability to rotate pictures (lossless algorithm).

s Every slide can be individually customized with its own time, effect, background, etc.

s Supports English, Russian, Netherlands, Italian, Swedish, Hungarian, Slovenian, German,
Catalan, French, Spanish, Arabic, Romanian, Chinese, Brazilian Portuguese, Danish,
Czech, Ukrainian, Slovak languages.



System Requirements

For slide shows with Pan/Zoom effects:
PC with 1.4 GHz CPU, 256 MB of system memory, video card with 128 MB of video memory.
Windows XP, Vista, 2000, 2003, Me, 98 or 95. DirectX 8.1 or later.

For slide shows created with simple effects:
PC with 500 Mhz CPU, 64 Mb of system memory, any video card. Any version of Windows.

System requirements for PicturesToExe and VideoBuilder:
PC with 500 Mhz CPU, 64 Mb of system memory, any video card. Windows XP, Vista, 2000, 2003,
Me, 98, 95. Note: burning of DVD-Video discs in VideoBuilder requires Windows XP, Vista, 2000.



What's New in PicturesToExe

Timeline is integrated to the main window now, pressing “Timeline” button switches between
Slide list and Timeline. You can add new slides to the Timeline from the File list. Parameters
of the timeline mode are located in the Main menu > View > Timeline Options. Waveform
displays mixed left/right channels, but you can turn on an independent view of left/right
channels waveforms. See timeline options in Main menu.

“Autospread slides along music” option is moved to Project options > Main tab.

Faster work of the timeline in very long slideshows (one hour and longer). You can adjust the
end of the slideshow on the timeline by dragging vertical green line after last slide. "Set End
of Last Slide at End of Music" command is added to "Timed points" menu in Timeline view.

Slide list displays pictures of real slides. (See Main menu > View > Advanced Options >
“Show real slides in Slide list” option) Preview displays real slides at the top-right part of the
main window. (See Main menu > View > Advanced Options > “Show real slides in mini-
player” option)

Mini-player is added to the main window. You can quickly play your slideshow in the small
preview window (press Play/Stop button) and quickly look at any part of the slideshow.

Quick access to any part of the slideshow.
Left mouse click for Play/Pause.
Right mouse click for fullscreen preview in both states: when paused and when it plays.
Main window now displays the duration of the slideshow (in minutes and seconds).
Other improvements in the main window:

Picture/Sound/Comment fields are moved to the top part of the window.

Reworked pictures of a folder, an improved view of a selected slide. Reworked view of the
drag'n'drop cursor in Slide list.

Improvements in Objects and Animation window:

Grid (Ctrl+G) to the "Objects and animation" editor is added. You can adjust parameters of
the grid and enable "Snap To Grid" option.

"Cut" button to the top toolbar is added.
Reworked view of Delete, Undo, Redo, Copy, Paste buttons.

New version includes official User Guide in PDF format, new Welcome screen (when you
first start PicturesToExe).

Visual improvements in Music tab of Project options.
Support of media keys on a keyboard: Play/Pause, Stop, Next/Preview slide is added.
Display pixel size of main image has been moved to the status bar.

Fixed problem with black screen on encoding of DVD-Video disc or AVI file on some
PCl/laptops with Intel integrated video cards.

Fixed crashes of PicturesToExe (main program only) and VideoBuilder under Windows Vista
with DEP protection (NX-bit) option enabled for all applications.

Improved burning of DVD-Video discs. Previously discs couldn't be burned on some PCs
with previous versions.

Added "Auto Save Project every ... minutes" option. (See Main menu | View | Advanced

options).



Questions

What are the system requirements for slide shows?
For slide shows with Pan/Zoom effects:

PC with 1.4 GHz CPU, 256 MB of system memory, video card with 128 MB of video memory,
Windows XP, Vista, 2000, 2003, Me, 98 or 95, DirectX 8.1 or later.

For slide shows created with simple effects:
PC with 500 Mhz CPU, 64 Mb of system memory, any video card, any version of Windows.

How can I register PicturesToExe?
Please open this page: http://www.wnsoft.com/apr

I bought PicturesToExe vX.xx. Should | pay again for next versions?

No, you need not pay for PicturesToExe again and you can use all future versions of
PicturesToExe free of charge. Besides, you will get two years of free upgrades for VideoBuilder
(module in PicturesToExe Deluxe). After two years' term you can use last version of VideoBuilder
installed on your computer or pay for upgrade to use its new version.

I don’t have an opportunity to download the program from the Internet. How can | purchase
iton CD?
You can purchase a CD with PicturesToExe from Barry’s Beckham web site:

http://www.beckhamdigital.co.uk/digitalav/pte/pte.htm

What screen resolution is needed to view the presentation?

You can use any resolution: 800x600, 1024x768, 1280x1024 or higher. A slide show in EXE file
uses the currently set display mode. All elements of a slide scale are visible automatically and
proportionally at any display mode.

Will PicturesToExe create presentations that can be viewed on Apple Macintosh computers
(Mac OS X)?

You can't run EXE file with a slide show on MacOS, but you can burn a DVD-Video disc in
PicturesToExe Deluxe and add EXE files of the slide shows. Thus, the DVD-disc will play with
highest quality on a PC (as an EXE file) and as a DVD-Video on Mac computer.

Can | put my slide shows (EXE files) created with PicturesToExe on CD or DVD discs?
Yes, of course!

How many slides can | include in my slide show?
Up to 20000 slides (unregistered version is limited to 10 slides).

What is the largest size that the generated EXE file can be?
The resulting EXE file cannot be larger than 2100 MB (2 GB).


http://www.wnsoft.com/apr
http://www.beckhamdigital.co.uk/digitalav/pte/pte.htm

What additional files are needed to run the EXE file of the slide show on my computer or
any other computer?

No other files are necessary to run the EXE file.

PicturesToExe v4.48 had the transition from/to desktop effect. | can’t find this effect in
PicturesToExe 5. Why?

We removed "Show transition effect from/to desktop" options in the new version of PicturesToExe
for two reasons:

This effect doesn't work correctly under Windows Vista due to an error in Windows Vista. Slide
shows created in v4.48, in which this option is used, will work as though they are created without
these options.

There is a problem even with Windows XP. Since version 5.0 we have used a fullscreen hardware
accelerated display mode (for maximally smooth playback of Pan/Zoom effects) and this option
could work incorrectly on some video cards.

Those are the reasons why we decided to remove this option.

Where can | download the examples of slide shows created with PicturesToExe?
You can find our slide shows at http://www.wnsoft.com/download.htm and a lot of slide shows
created by users of PicturesToExe at http://www.beechbrook.com/pte.



http://www.beechbrook.com/pte
http://www.wnsoft.com/download.htm

Problems

| lost PicturesToExe (PC crash etc.). How can | reinsrall the program without being charged
again?
You can download the latest version of PicturesToExe from:

http://www.wnsoft.com/apr/apr-deluxe.zip

You can request a new registration key at the technical support web page:

http://www.wnsoft.com/support.htm

Autorun doesn’'t work.
There are many reasons why it may not work:

1. Probably CD autorun is disabled in Windows system.
2. Theinffile and slide show exe file should be in the root of the CD.

I have launched PicturesToExe, but the interface language looks unfamiliar. How can |
switch to English (or another) language?

Open the fourth menu from the top panel of PTE window. Select the fourth line and then switch to
the necessary language from the list.

When | try to open/save one of my projects, it says that the images are not found.

This problem may be caused if you remove or replace any files (images, music), while making a
project or after saving a project. You shouldn’t remove or replace any files used in a show from
their original folders, because the program keeps in memory each file’s path in order to find it next
time you open your project.

When | create a show, my images look normal, but when | play a created presentation, color
gamma of these images is much brighter.

By default we use a hardware accelerated screen mode in v5.00. It allows us to attain ideally
smooth Pan/Zoom effects. This mode, used in Media Center, Chess Game and Aero Glass uses
the interface in Windows Vista.

Unfortunately, drivers of ATl video cards for Windows XP contain a bug. It ignores color gamma
settings in the fullscreen mode which you adjust for the desktop. ATl has already fixed this bug for
their drivers for Windows Vista and they also promise to fix it for Windows XP later.

As a temporary solution go to Project options -> Screen tab and uncheck "Use hardware
acceleration" option. But if you use Pan/Zoom effects it will not play smoothly enough.

You can complain to ATl and ask them to fix this bug as soon as possible:

Zoom/Pan transitions are “jerky” and not smooth.
1. Make sure that your video card satisfies the requirements for these effects.

2. Perhaps, the size of your images is too big. Try to reduce it and preview the show once again.
This is the link to our free program, which helps you to reduce the sizes of all images at once:

http://www.wnsoft.com/soft/MultiResize.exe (216 KB)


http://support.ati.com/ics/survey/survey.asp?deptID=894&surveyID=486&type=web
http://www.wnsoft.com/support.htm
http://www.wnsoft.com/apr/apr-deluxe.zip

3. If the show still has bad quality, please, report this to technical support. We would be grateful, if
you indicate your computer's configuration and write a detailed problem description in your ticket:
http://www.wnsoft.com/support.htm

| lost pictures which were used in a show. How can | get them back?

You can'’t extract images from exe files. We refused to add such ability to the program, because
many customers don’t want other people to be able “to steal” their copyrighted pictures. We can
only advise you to make screen shots of the images and save them.

Slide show hangs on a certain slide, but music continues playing.
Please, check to see if some of your slides have customized settings: right mouse click on a slide
and select Customize Slide menu item.

Ripped music “stutters”.
PicturesToExe is very sensitive to any errors in audio files, which may appear while ripping,
downloading or converting.

We can advise you to use "Exact Audio Copy" program to rip music from CDs. This program is
free.

DVD burning can’t be completed correctly: the progress stops, Video Builder says the disk
is full, recorded disc doesn’t play in a DVD player.
1. Make sure that your disc is not full.

2. Do you use high quality DVD discs? Please, try to use another disc and try to record once again.

If the program does not respond or you face any error messages, please, report this to technical
support service.

| burned DVD-video disc, but it doesn't play smoothly.
Before burning DVD-video disc, check TV system parameters in the project options. If you live in
the USA, Canada or Japan, choose NTSC. If you live in Europe, you should choose PAL/SECAM.

10


http://www.wnsoft.com/support.htm

How to...

How to upgrade PicturesToExe to the Deluxe edition? | want to burn DVD-Video discs with
my slide shows.

If you bought PicturesToExe v4.48 or earlier or you bought PicturesToExe Standard edition you can
upgrade to Deluxe edition and use VideoBuilder to burn DVD-Video discs:

https://www.regnow.com/softsell/nph-softsell.cgi?item=1639-3&ordertype=Upgrade%20to

%20Deluxe

How can | make my slide show (EXE file) start just after inserting CD or DVD discs into the
drive?

Create a new document with the name "autorun.inf" using any text editor (e.g. Notepad) and write
the following text:

[autorun]
open=YourSlideshow.exe
icon=Yourlcon.ico

Note: instead of YourSlideshow you should write the name of your slide show, and instead of
Yourlcon you should set your own icon. This file ("autorun.inf') must be copied to the root of CD or
DVD disc with your slide shows.

EXE file of my slide show is too large. How can | reduce the size of my EXE file?
@ Reduce your JPEG images to 1024x768 or 1280x960, 160-500 KB

@ Use MP3 files for background music (don't use WAV music files)

You can determine the size of your slide show by watching the status bar at the bottom of the main
window (3rd section - 'EXE file - 4 MB')

How can | calculate the size of a produced EXE file with my slide show?
The size of your EXE file with slide show is 280 KB plus size of your files (images and music).

How can | synchronize several groups of slides with a certain audio track?
To synchronize a group of slides with an audio track, do the following steps:

Select the necessary number of slides, drag the last one and set it exactly under the blue line,
which shows where the last track ends and the next one begins. Keeping these slides selected,
click <Timed Points> button and select "Arrange selected points". As a result, all these slides on
that area will be set on equal distance one from another. Then add next group of slides to the time
line: click <Insert slide> button, select necessary images and click <Add> button, and do the same
steps with them.

How can | fade music in the end of each track?
PicturesToExe doesn’t have audio editing abilities. You can make fade effects with any audio editor
and then add this track to a slide show.

| want to add one or more MP3 music files to my slide show as background music.
Go to Project options, Music tab and add music files (MP3, WMA, OGG, WAV, MID) which will play
in your slide show. After the last file ends, optionally, the first file will be played again and so on.
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How can | create an independent video file (not on CD/DVD) and save it on my hard drive?
You can create a custom AVI file:

Click <Video> button, check "Create custom AVI file", then select audio and video codecs: <Audio
codec> and <Video codec> buttons. You can choose any video codec, except "PicturesToExe
video codec". You can select codecs from the lists or use your own codecs. Then click <Create
AVI> button and save your file.

How can | make a screensaver and set it for my computer?
Create a slide show as a screen saver. Save it in any folder of your computer. Right click on it and
select menu item to set it as a screen saver for your PC.

How can | transfer my PicturesToExe to another computer?

You can copy the distribution program PicturesToExe to any removable media (CD, flash memory
device etc.) and then install to another PC. Then register it with your current key. If you don’t have
back-up copy of your registration key, you can always inform technical support, and you will be
given a new key:

http://www.wnsoft.com/support.htm

How can | avoid black strips at the top and at the bottom of the screen in my slide show?

If you watch any wide screen slideshows (say 16:9) on usual LCD display at 1024x768 (4:3), you
will see black strips at the top and the bottom parts of the screen. If you don't want to see these
black strips and you would like to use all of your display for a slideshow, use "Pan and Scan"
feature of PicturesToExe. Create MyShow.bat file in Notepad and type:

"MyShow.exe" - Cover

See the result below:

It works for all EXE files with slideshows created in version 5.0 and later.You can distribute a ZIP
archive with your slideshow with EXE file and additionally include .bat file for fullscreen version:

MyShow_Widescreen.exe
MyShow_PanAndScan.bat

12
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Quick Start - PicturesToExe

If you want to make the slide show, do the following steps:

w2

Open PicturestoExe;
Open the necessary folder with the images from the directory tree of files;
Add the selected images to the slide list;

Then Customize slide and add Object and Animation to it, if you wish, in the preview
window;

5. After that, customize your slide show in the Project Options;

7.

If you want to preview your slide show, click the button Preview and after that make some
changes, if necessary.

Your last step is to create the EXE file with your slide show by clicking the button Create.

That is the way to create the simplest slide show and EXE file.
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Quick Start - VideoBuilder

If you want to burn a DVD-video disc with your created slide shows, do the following steps:

1. Click Video in the Control Buttons panel of the PicturesToExe and select Burn DVD-
video disc;

2. Add the necessary projects to the project list and click Next;

Customize the menu of your disc by choosing the background and adding music to it and
press Next,

4. After that, select the place on your computer for saving temporary files and ISO image of
your disc and click Start for burning the disc.

That is the easiest way to burn DVD-disc with your projects.

14



Main Window Menu

As you can see, the main window menu consists of a number of smaller windows and icons. They

are:

A Autumn - PicturesToExe Deluxe 5.5
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|C) PicturesToExe 4.43
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the main menu;

the drive selector;

the directory tree of files;

the file panel;

the preview window for a selected slide;
the control buttons for a selected slide;
the slide list;

the control buttons;

the status bar.
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Main menu
At the top of the main window you can see drop menu:
m file menu;
m project menu;
m slide menu;
m View menu;

m help menu.

File menu
File menu has the following options:

m The New - this option is used to open a new project.

=™ Froject Slide Wiew Help m The Open - is used to open earlier saved projects.
Mew. ., Chrl+N m The Save and the Save As will help you to save created
Open, .. Chrl+O projects under their own or new names.
Save Chrl+5

m The Create Backup in ZIP — this option will help you to

i?::t:;aclmp — Alb+E save all your projects in ZIP format. It's helpful for making
Templates , reserve copies of your slideshows if you want to save
Open Recent Project N them and then take them to another computer.
Create Slideshow Fo m The Templates — this option provides you to save existing
Create Slideshow As. . Fa projects and to use them as the templates while creating
Create Slideshow and Fum. .. CHI+FD next slideshows. Opening this feature will bring you to
Create Screen Saver... 7 another dialogue box the Manage Templates and the
Previcw F5 Create Template from this Show. The Manage
Templates means to save projects in one directory file
Burn DYD-¥ideo disc... Shift-+F1 and then to use them in creating a new slideshow with the
Create AVI file... Shift-+F2 settings saved in templates (The Create templates from
Exvit =T this show).

m The Create Slideshow and the Create Slideshow As are two options, which help you to
create exe files and save them under different names. The Create Slideshow and Run
means to create an exe file and run it immediately after its creation.

m The Create Screensaver helps you to create your slideshow in scr file. You may use your
slideshows in this format as animated screensavers.

m The Preview option is used to preview your slideshows from the beginning to the end before
creating it.

m The Burn DVD-Video Disc option is needed to put created slideshows on DVD or Video
discs and then run them in DVD players or other computers.

m The Create AVI-File option means to make AVI-File and then customize it in other editing
programs.

m The Exit option allows you to exit PicturesToExe.

16



Project Menu

Project Menu consists of such options as:

Slide View Help

Lndo Ctrl+2Z
Actions on File List »
Customize Startup Window...

Customize Help Message. ..

Timeline Ctrl+
Project Options... Ctrl+P

m The Undo and Redo options will help you to make some
changes while creating your slideshow.

- Actions on File List - this

Actions on File List

Unselect All Pickures
Add Selected Picture(s) to Slide Lisk
Add all Pictures ko Slide Lisk

3 Customnize Startup Window, .
Customize Help Message. ..

Timeline CErl+L

Riokate clockwise (lossless)
Rotate counterclockwise (lossless)

Project Options. .. Chrl+P

‘E‘ Favarites
=5 My Docurnents

F
Rename

Select All Pictures

option goes to the selected file
in the directory tree. With the
help of this option you can
select or unselect all pictures at
once and add them to the slide
list. It will save your time as the
work will go more quickly.

CtHD

fist YR ¥ R T ST

Bk J

m The Customize Startup Window, the Timeline option and the Project Options will be
described thoroughly later (see Projects Options, Main Tab p. 40).

Slide Menu

Slide Menu has a number of options, which are related to the slide itself and its characteristics.

View Help

Copy Slide

Chrl4+1
Zkrl+B

Custaomize Current Slide. ..

Ohjects and Animation

Reset Personal Settings of all Slides
Set Comments on All Slides = Current One  Chrl+M
Random Crder AlE+R

Remove Slide From Slide Lisk
Clear Slide List

Rotate clockwise (lossless)
Rotate counterdockwise (lossless)

Renarne

m If you want to Copy, Rename, Remove Slide from
Slide List or Clear Slide List you should use the
necessary buttons.

m Other options such as Customize Slide, Objects
and Animation are related to the characteristics of
the slide. They are needed to adjust the slide and
will be described later in more detail (see
Customize Slide p. 24 and Object and Animation
p. 28).

m You may Rotate your slides clockwise and
counterclockwise with the help of consequent
buttons. It is important to note, that it is a virtual
rotation in PicturesToExe and the initial files with
images won't be modified.
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View Menu
View Menu provides options, which will help you to adjust your main window:

Help m The File List Sort Order is used to choose the necessary
order of your files according to the name, extension, date or

File List Sort Order r
Advanced Options 3 size and so on.
Timeline Options 4
Language 4
Classic View Cirl4F1

® Horizontal View Cirl4F2
Vertical View Cirl4F3
Timeline View CirlH

v Show Tree Cirl4G

v File Panel as Thumbnails Ctrl+1

v Slide List as Thumbnails Cirl+2

Fullzcreen View of File Panel... F3
Fullzcreen View of Slide List... F4

v Show captions in File Panel
v Show captions in Slide List

m If you click on Advanced Options, the following dialogue box will be opened:
Here you can see different options:

Advanced Options Path and Mame of Sound Editor, .,
Timeline Options 4 Auko Save Project..,
Language 4
v Lossless compress BMP Images
Classic View Chrl4+F1 Allows modification of EXE File with slide show
® Horizonkal Yiew Ctrl4+F2 N Stvle of 1 Whesl (M )
Vertical View Chlgpy | ¥ on Suvie o louse Whesl L Mouss
o . v Load Last Used Project
Timelineg View Chrl4L
v Enable PTE Program Sounds
v Show Tree Chrl+3
& Customize Slide on Double Click,
v File Panel as Thumbnails Chrl+1 Objects and Animation on Double Click
Slide List as Thumbnails Chrl+2
v v Use hardware acceleration in Editor and Yideo
Fullscreen YWiew of File Panel... F3 v Show real slide in mini-player
Fullscreen Yiew of Slide List,,, F4 v Show real slides in Slide List

a Path and Name of Sound Editor helps you to insert the location and the name of any sound
editor you wish.

@ Auto Save Project gives you an opportunity to save your project automatically while working
on it every so many minutes as selected from the menu.

a Lossless Compress BMP Images helps to compress images of BMP format, Allow
modification of EXE file with slide show, Enable PTE Program Sounds are self-
explanatory.

@ The next two options Customize Slide on Double Click and Objects and Animation on
Double Click may be chosen depending on your preference and frequency of usage of
these two features.

@ New Style of Mouse Wheel (X Wheel) gives you an opportunity to scroll any window you
choose without clicking on it. This option is very helpful and saves your time.

@ Selecting the feature the Load Last Used Project is necessary, if you want the last project
automatically opened, when you open PicturesToExe. It's very convenient, if you work at one
project for a long time.
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a Use Hardware Acceleration in Editor and Video should be selected for better quality when
using animation effects, but if you don't have very good graphics card, you should switch this
option off.

@ Show real slide in mini-player and Show real slide in Slide List are two options, which
help you to see the real size of the slide (the size like in the slide show) in the preview
window and in the slide list.

m The Language option includes more than twenty languages.

m You may also choose among three views of the main window: Classic, Horizontal and
Vertical Views and the views of File Panel and Slide List.

m There is also one option, which will be described in details further. It is the Timeline option.
Here you can see such functions as:

Here you can choose between styles

View WgEls
Fie List Sort Order , of the Auto Scroll, to select the color
Advanced Options R | 3 @ of the Waveform and some other
Don't e Auto-Seoling functions.
Language 3 Auto Scroll - Style 1
o Auto Scroll - Style 2
Classic view Cirl+F1
® Horizontal View Cirl4F2
Vertical View Cirl4F3
Timeling Yiew Ctrl+
Color of Waveform
v Show Tree Ctrl+3 Display Waveform as... 4
Help Menu

This option gives you an opportunity to find answers on all your questions and to see how different
options may function. On clicking this menu, the following dialogue box will appear:

m User Guide Online opens the page of our official site where

User Guide Online. .. F1 . .

Download User Guide in POF... you can find the User Guide.

What's New... m Download User Guide in PDF helps you to go to the
Useful Resources... necessary place in the site and then download and save the
Registration. . User Guide to your computer.

Welcome Screen... m What's New — the option, which gives you a link to the
About PicturesToExe. .. website, where you can see what is new in the new version

of PicturesToExe.

m On clicking Registration, you will see the following window, where you can register your
version of PicturesToExe:

Here you can read conditions of the purchase and

registration and make all necessary things to buy registration
E key and to register your version of PicturesToExe.

Some benefits of registration PicturesToExe:

* 10 slide limit is removed

* Registration “nag-screen” will no longer appear

* You may request technical support

» Al future versions of PicturesToExe will be free for you,
and you will get two years of free upgrades for VideoBuilder
(program to burn DVD-Video discs).

Standard edition - $39
Basic edition of PicturesToExe.

Deluxe edition - $59
This edition of PicturesToExe additionally includes VidecBuilder for
easy burning slide shows on DVD-Video discs.

The on-line order form:

hitp:iwnsoft comiorder.htm
This page is located on a secure server, ensuring that your personal
information remains confidential.

Copyright (c) 1998-2008 by WnSoft. Al rights reserved.
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m On clicking Welcome screen, the following window with all opportunities of this program is
shown.

\

Welcome to'PicturesToExe!

!

m About PicturesToExe option gives you information about the developers of this program:

PicturesToExe 5.50

Licensed to
Olga (Deluxe Edition)
All future versions of PicturesToExe for free

Wisit our Web site:

www winsoft.com Developed by:
|gor Kokarey

Technical support: Aleksay Elin

www winsoft.com Pavel Koshkin

Copyright (c) 1998-2008 by WnSoft
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The Directory Tree of Files
The drive selector and the file panel is represented on the left side of the main window.

S— It's an ordinary window, where all directories and files of your
% = ‘%? % | %| % computer are arranged on different drives. It's very convenient
— to choose among them and to look for the necessary directory
or file. When you choose a file in the directory of interest and
click on it, this file will appear in the file panel.

|5 Messenger |
) Microsoft ACT )

[C5h Microsoft ActiveSync

|5 Microsoft Chat
|5 microsoft frontpage
[T Microsoft Office
|5 Microsoft Visual Studio JNET
[ Microsoft Windows Small Bu
{5 Microsoft.NET
[ Mavie Maker
[ MSN Gaming Zone

|5 MetMeeting

[ Orline Services : T S
[ OpenOffice.org 2.0.1
|5h Opera

|5 Outlook Express
|5 PicturesToExe 4.43
|5 PicturesToExe 4,43
|5 PixBuilderStudio

() PRMTS
|5 Rambler Assistant |
|y visbroker .
1~ Windows Media Component | el e feete
£ [ > =

Above the window, which is on the right, you can see several icons. What do they mean?

L this is the feature for adjusting the size of the images in the selected file;

& this icon changes the file directory tree to a full screen window, where you can see all files and
images more clearly;

= this icon gives you a short way to go to the file My Documents;
this icon gives you an opportunity to go up to one level while searching for the necessary
image.
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Preview Window for a Selected Slide or Image

When you click on the necessary image in the file panel or the slide list, it will appear in the
Preview Window for as a Selected Slide or Image. You should remember, that if you choose the
image in the file panel, it will just be seen in the preview window and you won't be able to
customize it. But if you choose the slide in the slide list, you will be able to make all necessary
changes. Here you can see the chosen image and some of its control buttons.

m Main image shows the
Comment | B| [F]..ums_5510b @ Add sound current  position of your
chosen file.

m In the Comment box you can
write any suitable comment to
the image. If it's not very
convenient for you to write in
the comment line, you can
click on the icon next to the
line. The dialog box will
appear and you can write any
comment. You will see this
comment on the very slide
you have chosen.

m In the Add sound box you
can add the necessary sound
file to a certain slide. If you
want to add music or some
sound commentary, you
should double click on the

b m 0001501 J 00:39 icon beside the sound line

and the dialog box, where

[ Customize Slide ” Ohjects and Animation ] Slide 10f 12 %/OU can choose the sound file
0 open.

m Below the main image you can see the timeline bar, where you can preview the slide show.
On the left of the timeline bar there is the display, which shows the position of the current
slide. On the right you can see the total time of the slide show.

m Here you can also see two buttons Play/Pause and Stop. Play button is used to begin the
preview of your slideshow in a small preview window. This button plays two roles: Play and
Pause. If you click on Play it will turn n Pause and vice versa. When you click on Play, the
blue triangle will stand at the beginning of the timeline and will move to the right on the bar. It
is necessary to add, that right click of the mouse on the preview window gives you an
opportunity to see the slide show on the whole screen.

Here you can also see two buttons: Customize Slide and Objects and Animation. They are used
for adjusting each slide, which you choose and which appears in the preview window. These two
functions will be described in detail further (see Customize Slide p. 24 and Object and Animation
p. 28).
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The Slide List

The Slide List is the place in the main window, where all slides, which are selected for the slide
show, are situated. It's important to note, that all slides are set up in a certain succession, and you
can move slides by dragging them in the necessary direction. You can add images in the slide list
in several ways:

m by double clicking on the image in the selected file in the directory tree;

m by clicking on the image and then clicking on the button Add, which is situated in the Control
Buttons panel;

m by dragging the image with the help of the mouse, in this case it will look:

As seen from the figure, keep clicking on the
image and drag it to the necessary place. The
black line behind the image shows the place
where this image will be set.

IMG_T7775.0PG

2.bmp 3. IMG_5564.bmp 4. IMG_5590.bmp | 5. IMG_0046.5

If you want to make some actions on the chosen slide in the slide list, you should right click on this
slide and the following box will appear:

Copy Slide Cirl+C | m You can Copy, Paste, Remove the slide or Clear the
Slide List.

Remove Slide from Slide List m With the help of the next three buttons you can change

Clear Slide List the order of images in the slide list. You can Move the

Move to Top Cirl+Home selected image to_ Top or End, you may choose

Move to End Ctrl+End Random Order of images.

Random Order Alt+R m Option Rename allows you to rename the image and

Open picture Crl+w give it another name or title.

Customize Slide Ctrl+U m Start Preview from the Current Slide means that you

Objects and Animation Cul+8 can see the slide show not from the beginning, but

Rotate dockwize {Jossless) Cirl+F from the slide you choose. It's convenient, if you want

Rotate counterdockwise (ossless)  Alt+F to see some effects or a transition from one slide to
another and you don't have to wait till that very slide.

Rename 2 It's necessary to note, that this menu has the same

options as some of the drop menu and control buttons.

Start Preview from the current siide Ctrl+R | It's just more convenient and quick to use this box
while working at the slide show, because all necessary
options and functions are gathered together.
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The Control Buttons

With the help of the window The Control Buttons you can perform different actions and create the
slide show. Here you can see the following buttons:

[ Create ][ Preview ][ Video ] [ProjectOpuons H Timeline ] [ Add ][Remove Slide ][ Clear List ] : El

Create button is used when you have finished customizing your slide show and want to
create it as an exe file. This format is very convenient, if you want to move this slide show
to another computer or just keep it as an exe file in your own computer. You should
remember, that if you make some changes in the slideshow and then you press Create
button, the last exe file will be rewritten. So if you want to save both exe files, the first and
the second variant, you should use option Create Slideshow As... .

Preview button allows you to preview the whole slide show from the beginning up to the
end. If you want to preview it from a particular slide, you should use the button, which is
found by Preview.

When clicking on Project Options, a large dialog box with numerous options and settings
for your slide show will appear. A detailed description of this button can be seen (see
Projects Options p.40).

Video button will help you to create a DVD-video disc or an AVI-file. It depends on what
you need. This feature will be described later (see Video Options p. 59).

Timeline option is necessary for synchronizing images to music. On clicking this button you
will see the timeline window, where you should do all adjustments. This function will also be
described in more details further (see Timeline Operation p. 55).

Add, Remove and Clear List buttons are related to the slide list and are used to add new
images, remove unnecessary ones and to clear the whole slide list.

The explanation of icon was given earlier in the article about the directory tree of files.

The Status Bar

At the very bottom of the main window you can see the status bar:

Modified

EXE - 29.5 MB 3198KE P | 1280x 853 X: \Images\IMG_5590, bmp [JHeld time points

The first word «Modified» means, that there were some changes made in your project. If
you save these changes, this word will disappear.

The next box shows the file size of the main image of the current slide.
In the third box you can see an approximate size of your exe file after creating it.

Further you can see the size of the image, which is in the preview window, and the directory
where the selected image is situated.

There is one more point in the status bar, which is also very important — Hold Time Points.
The default is, that this option is unchecked here. The meaning of it is, that if you add new
images to the slide list, the other images are moved to give space for the new image on a
certain number of seconds, which you have set for showing each slide. But if the option
Hold Time Points is checked, the images will not be moved and the slide will be added
without adding the space for it.
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Customize Slide

If you click on the button «Customize Slide» in the preview window the following dialog box,
where you can see three tabs: Main, Effect and Music Tab, will appear.

Timing
Options Timing, Background and Advanced Options are found in the Main Tab. Timing
includes the following features:

Customize Slide #3 53] = Display slide for (sec.) - here you can put the
— number of seconds and milliseconds and this
image will be displayed for a desired period of
time. You can also use up and down arrows for

Use customized settings for this slide

Main | Effect | Music

UnliE setting the time.
Display slide for (sec.) 4] *|sand |0 | ms . .
m The next menu gives you an opportunity to
[ 5cale keypaints in objects {on time changs) choose among the options, which are self-
explanatory. You should just select what you
Mo actions after this slide v need.
Mo actions after this slide w
Background -
Mo actions after this slide
Use own background preference: Stop at the end of this slide

Loop this slide

() Background color =

© Gradient filing Sz ofimage 20,0 1| % @ For example, if you set Stop at the end of this

AT T slide for the third slide, the slide show will be
stopped, till you click Right on the keyboard.

Advanced options

[]Run external application: @ If you select Loop this slide, in this case, the
slide will get caught in an endless loop. If there
is animation in this slide, it will also be looped,
till you press Right. This option is very useful
for creating the menu, from which the slide
show will go further.

[ [0]4 H Cancel ” Set Defaulis

m Scale keypoints in objects (on time change). If you set several keypoints to the slide and
then change the time of display (e.g. from 8 to 16 seconds), this option will automatically
correct these keypoints (e.g. from 4 to 8 seconds). Look at the example below:

n | T From this example you see,

TlSDDms‘ 1500 ms, f that the time of slide dISpIay is
8 seconds.

o Here we set the time of

T £ LDM.T display up to 16 seconds, but

don’t switch on the option
Scale keypoints in objects (on time change). The time from the first to the second keypoint
hasn’t changed.

. EmEn ‘ . Here we also set the time of

= so0ms.| the slide up to 16 seconds

and switch the option Scale

keypoints in objects (on time change) So the time from the first to the second keypoint is twice
bigger now.

TISDD ms,
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Background

It's important to note, that this option is necessary, if the size of the image does"t fit the whole size
of the monitor screen and you should fill the left place with some color or background to be exact.
Here you can choose among Background Color, Gradient Filling and Tiled Background
Picture.

m If you choose Background Color, just simple color will appear. To choose the color, you
should click on the button «A» beside and you will see the following dialogue box.

Choose color @] Using this color box, you can choose
e EY ETE Reference any color you wish. You can also
New: choose between RGB and HSL, which
o is the modification of RGB. You can
NI 1Ee adjust all necessary parameters.
OO0 NEN o om
BOCONNCONN R o 3
HECOEEEEEN & o 3
EEEEEEEN B o 3
BRI
% 000000
.. | I OK l [ Cancel ]

m If you choose Gradient Filling, you will see the next box.

Here you can choose between Top-

HoEanna Bottom Style and Left-Right Style.
[+] Use own background preference: It means that you can add color
background at the top or at the
() Background color - A - A bottom of the screen or on the left or
® aradient fling right side of it. To select the color,
B Top-Bottom style hd you should also click on the buttons

() Tiled badkground picture «Av.

m If you choose Tiled Background Picture the following box will be shown.

As you can see, by clicking on the

folder, you can select the image

[+] Use own background preference: from any directory file you wish and
adjust its size.

Background

(" Background color =
() Gradient filing

Size of image 20,0 | %%
() Tiled background picture

26



Advanced Options

Advanced Options include the button Run External Application. On choosing this option you
can add to your slide show any application from any directory file. It may be any picture, menu,

slide show and so on.

Effect Tab

If you want to add some settings for the slide or to use transition effects, you should have a look at
this tab. Here you can choose among a great number of different transitions by clicking on them.

Customize Slide #3

Use customized settings for this slide

Mair | Effect |Music

Use own transition effect:

() Uge default effect (but with own duration)
(7 Quick (no transition effect)

Fade in/out

() Fade infout
Hour hand

(O Clodkwise

() Counter-dockwise
Circle

O To center

(O From center
Rhombus

(O To center
O From center

Center:

o wso

[]own thickness of smoothing line: 6,0 W | op

Effect duration: 1500 % | about 1 second(s)

[ Ok H Cancel H Set Defaults l

You can select Fade in/out, Hour hand, Circle,
Rhombus, Rectangle, Gates, Page Effect,
Advanced hour hand, Mosaic, Push Effect,
Slide Effect, Curling of Page. To see how these
transitions work, just click on them and have a
look.

You can also adjust the thickness of smoothing
line and Effect duration which is the time of
continuance of this effect, by using up and down
arrows for setting the time.
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Music Tab

If you want to add music to the slide, you should use Music Tab.

Customize Slide #1 E
Use customized settings for this slide

Main | Effect | Music |

Background music for show

Play new background music file(s)

[ Add music l ’ Remaove ” Clear

To add personal music for this slide you should
turn off "Synchronize music and slides™ option.
See Project options | Main tab.

|C:‘|,Documents and Settings\All Users\JokymeHTe!MoA Mysbn{a\pﬁpa:l

Mote: Current music will be stopped if playlist is empty.

[ oK H Cancel ” Set Defaults l

Note, that the sound file you choose, will be
added only to an individual slide. If you want to
add music to the whole slide show, you should
use Project Options, Music Tab, where you
adjust not a single slide, but all the slides in the
slide show.

You should remember, that if you add music file
in this way, the music will be stopped after the
slide is shown.

Here you can also Add several music files,
choose among them, Remove them and Clear
the playlist.
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Objects and Animation

Main Window

In addition to the customized settings of the slide, you can adjust some other options, such as
Objects and Animation.

B4 Objects and Animation (Slide 3 of 8)

O A e | X| | B2 % @B | H Auto 1w o

#| | Properties | Common |Animaﬁon|
Name MG_5510

Action on mouse dick

None hd |

|:| Perspective correction for Zoom
[ Transparent To Selection

Time range 12000 (5| (19500 &
Mode Fit to slide A

Objects (1)
IMG_5510

v

E] \ B
oz oo |
T
TISOO ms, 1500 ms.
(e ) [ ) ()

Duration: 00:07.500 Position: 00:12.000 X:\Images\IMG_5510.bmp

When clicking on the button Objects and Animation in the preview window, the main window,
which is shown above, will appear. Here you can see the information bar in blue color, where
you see the name of the file, which you have selected. Under the information bar there is the tool
bar, which includes a number of icons.

7 o A [ ] e e By % 2 i o v [ Cose |

With the help of the first icon Frame you can add frames to the slide. If you add the frame, an
image or a group of images will be dependent on it. It means that a frame will be a parent
and all images inside it will be its children. You can adjust a lot of options: color, opacity,
drop shadow, pan/zoom, size of the frame and so on.

The next icon Add Button helps you to add buttons to your slide. With the help of it you can

1 make different actions to the slide and to the slide show on the whole. For example, you can
exit the slide show, go to the next or previous slide, make a pause, send e-mail. The whole
list of all possible functions you can find in the common tab on the right side of the main
window. As well as with the Frame, you can customize the view of the button according to
the color, size, shadow. You can also add the necessary text of any font, color and size.

@ The icon in the form of «A» helps you to add the text to the image. You can choose font,
— size, also shadow, pan/zoom and other options here to make your comment fit the style of
the image and the slide show.
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The fourth icon Rectangle as well as frame may be used for making slide shows more
animated. It may be also used as backgrounds to the images.

On clicking the fifth icon Add Image the dialog box, where you can choose the necessary
image from the directory tree of files, will appear. If you want your added image to be
independent from the other objects, you should see, that no objects are highlighted in the
object list in the right lower corner of the main window, before clicking on this icon.

The next button Delete is used, when you want to delete the selected object from the object
list. You should remember that if you delete a parent object, all its children objects will also be
deleted.

The icon Undo and the > icon, that means Redo, give you an opportunity to make changes
during your work till they are not saved.

The last icon here, which is called Show/Hide Grid, helps you to set or hide grid, if
necessary, for better and easier customizing of the image. If you click on this icon, you will
see the following view:

This grid is very helpful, if you want to customize buttons or frames and to set them regularly.
It is centered on the image from the left upper corner. You may also customize the grid on
clicking the button near the icon «Grid». In this case, you will see the following window:

First you can customize the Color(s) of the grid by clicking the button «A». The first box is for

the whole grid and the second box is for every tenth cell of
Color(s) A - A the grid. From the example you can see, that the color of
the whole grid is green and of every tenth cell is orange.

[mnpixels ] You may also show this grid in pixels or just in columns.
Moving the bar near this option gives you an opportunity to

[¢Snap To Grid enlarge or diminish the grid. If you set to show the grid in
ot - A 1 [ c columns, you will see two boxes with numbers, where you
= - can set the necessary number of columns vertically (the

first box) and horizontally (the second box).
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The Offset is used, if you want to move the grid relatively. You can move the grid up and down or
to the left and to the right with the help of arrows, which are situated beside the option itself.

The ninth and tenth icons Copy and Paste are used to save images and other effects and to
use them later with other slides. It's very convenient, if you want to use similar effects and
transitions with several objects. You just should highlight the necessary effects in the object
list and click the button Copy, then open the next slide and press Paste. All effects will be
applied to that image.

The next icon shows the scale of the slide. You may choose the necessary percent from 10%
to 500% for better view of the image. It's convenient, when you want to have a look at the
image, but the size of it is very large or small. If it's large, you may reduce the Percentage
View up to 10% if you can't see the whole image at 100%. On the other way, if the image is
too small, you can put 100% and more for better look at it.

The last icon, Close, allows you to close the main window of this option Objects and
Animation option.

31



Properties Tab

The Properties Tab is situated on the right side of the main window of the option Objects and
Animation and shows the main characteristics of the image or object. Here you can see the
information where this image or object is located on your computer.

You can also choose whether the slide is the main image in the object list, whether the edge
antialiased and whether there is blurring.

m The Edge antialiasing should be normally turned on. It is
used to minimize the distortion of some artifacts of high
Picture [¥:\Images\IMG_5523. g3 | resolution images, when they are shown at low resolution.

Properties |Ccmmon || Animation |

m Blur feature is very convenient if you want to minimize the

[#] Main image . X
pulsing of the image when you zoom.

[¥] Edge antialiasing m Low quality of resizing is the feature, which shouldn't be
[C1Blur always used. It's helpful only when the quality of the image is
not very good and you have white lines in your image.

[ Low quality of resizing

For better understanding of the functioning of this option it is better to see the difference. Both
images are zoomed out.

The first variant is made without the option Low
quality of resizing, the effect is degraded.

The second variant is made with the help of Low
quality of resizing and the picture seemed to be
more legable and sharp.

32



Common Tab

The Common Tab is found next to the Properties Tab and includes the following options:

Properties | Common | Animation

Mame |IMG_DIZI46

Action on mouse dick

Naone

vl

[l orop shadow

|:| Transparent To Selection

|:| Perspective correction for Zoom

Time range |D S | |55IZID S |
Mode |Fit to slide v|
Position |In percents b |

m First you can see the Name of the image you have selected and

adjust.

Then you can choose the Action on mouse click: None, Exit,
Next Slide, Previous Slide, Help and so on.

Perspective Correction of Zoom is used instead of camera
zoom.

Transparent to Selection gives you an opportunity to make
changes in the selected object without touching the other
objects, if there are any.

Time Range — here you can set the time to display the image in
the slide show. But you'd better use timeline window.

You can also select the Mode among Original, Fit to slide,
Cover Slide. Original is the real full size of the slide and it's not
very convenient to use. It's better to use Fit to slide mode or
Cover slide mode while customizing the image.

Mode Fit to slide W

Pasition

m You may also fit the position in pixels or in percents.

m You can customize Drop shadow (the figure is shown below). Here you can select the Color
of the shadow by clicking in the color box. You may set Opacity from 0% to 100%, Angle and

Drop Shadow and Glow

Drop Shadow and Glow

Calor:

Opacity: |

J

Distance: | J
Size: | j
‘ Spread -

[ Drop shadow templates ']

Lo

H Cancel ]

Size of the shadow, Distance from the image and
x| Spread (Form) of the shadow. At last you can
— save shadow as the Templates.
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Animation Tab

Animation Tab contains such options as Pan, Zoom, Rotate, Opacity and some others, which
will be described further:

Pan

Properties | Common | Animation | m Pan effect has horizontal and vertical positions, with the help of
which you can move the image left/right and up/down. As you can

12,351 G| x [5562 G see from the figure, you may customize it with the help of up/down

Linear -] arrows. The left block links with the left and right movements of the

image and the right block links with the up and down movements.

zoom |73,318 = [mIm 2 You may also move the slide by dragging it with the help of the

mouse. In this case, the display in these two blocks will be changed

Sl d automatically.
Rotate [0,000 | m Zoom effect helps you to enlarge or diminish the image, it depends
— -] on your choice. You may do it with the help of up/down arrows or by

Center (0,000 & |x 0,000

dragging the green rectangle of the image with the mouse. There is
one special feature in this option. You can see a small square
between the boxes with arrows, by default it is turned off, and the

L

Opacity 00,0 v slide changes its size proportionally, that is the figures in both these

Keyframe Time a

boxes are the same and the slide just changes its size without
changing its form. But if you turn this small square on by clicking on
it with the mouse, it gives you an opportunity to change not only the
size of the picture, but also the form of it. It means that you can compress or extend the
image. With the help of the arrows in the left box you may change the image horizontally and
in the right box vertically. If you change the image and then you want to make it proportional,
you can just turn this small square off and the slide will become proportional again.

L

Rotate effect gives you an opportunity to rotate the image clockwise and counterclockwise.
The default setting is zero here. If you click on the arrow in the rotate box, the following dialog
box will be opened.

Here by moving the cursor in this box, you may rotate the image in
both directions. It's important to note, that you may also move the slide
J dragging it by the angle of the green rectangle, which you may see if
the object is highlighted.

Rotate |-360,00C w

Center effect is a very powerful feature, which gives you a lot of opportunities in animating
and customizing the images. It's important to mention, that the center of any image or object,
which you want to adjust is situated in the real center of it. If the image is highlighted, you may
see this center, which is shown by the green circle in the green rectangle. If you want to
change it for some reason, you may do it with the help of this option. You should press Shift
and drag the center with the help of the mouse simultaneously in the direction you wish. That
will be your center of the image from that moment. You may now move the image and the
center will be on its new place. In the boxes with up/down arrows you may change the
figures and the image will move relatively its center horizontally and vertically. If you use the
arrows in the left box, up arrow helps you to drag the image to the left, down arrow to the right.
If you use arrows in the right box, up arrow moves the image up, down arrow moves it down.
This option is also very helpful not only in moving but also in rotating the slide. To have a look
at all possibilities of this option, it is better to experiment with it.

Opacity effect also helps you to make a lot of different things and views. Opacity varies from
0% to 100% that means you can make the image invisible at all or vice versa visible. The
default setting is always 100%, but you may change it by dragging the cursor in the opacity
box. You may add several objects or images and set different opacity for all of them. The effect
is very beautiful. For better understanding of this option it is better to try to work with it.

Keyframe Time option shows the time of the current slide from one keypoint to another one
and will be described further (see Timeline Operation p. 55).
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Linearity

In several options such as Pan, Zoom and Rotate you may find Linear movements of the image,
which you may adjust. When clicking on it, the following dialog box will appear. Here you can see
Settings up, Linear and non-linear features: Accelerate, Slow Down and Smooth.

Linear

Setting up...

Linear

end.
Accelerate

,] m Linear means that an object or an image moves (begins, continues
and ends) with one and the same speed.

m Accelerate begins slowly and then accelerates up to the end.

m Slow Down begins at a high speed and then decelerates up to the

m Smooth begins slowly and ends also slowly, but in the middle it moves

Slow down

Smooth used.

with linear speed. More often Linear and Smooth movements are

First you should choose linear or non-linear movement, then click Setting up and the next box will

be opened.

E Speed options

- First
1 @
Ly

Separate here

=
=

Glue here

Separate here

5 % Last —

100% [

100% [

0

. 100

LA

]

. 100

LEEL

Templates... oK

l ’ Cancel
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Here you can see the number of
keypoints, which you have created for a
certain image in the timeline window. You
always have the first and the last keypoint
and a number of inner keypoints. The first
and the last cannot be changed, but inner
keypoints are changeable. You can see
the scissors on the inner keypoints, which
may help you to seperate the movement
or vice versa to glue it. The difference is,
that if you separate, the movement will
not be smooth. So it is better not to do it
and to leave it as it is. So if you make
some changes here, you should make
them also in Pan, Zoom and Rotate
options. It's important to note, that you
may save these speed options as
Templates and use with other images.



Object List

Object List is situated in the right lower corner of the main window of Object and Animation.
Here you can see the list of images and objects, which you have added and work with.

You can add objects to the object list in several ways:

Objects (5) m by selecting the buttons in the tool bar above the preview window: Add
IMG_ 7808 Frame, Add Button, Add Text and so on;
Frame m by right clicking on the preview window or the object list, where pop-up menu
IMG_77785 will appear and you may choose the necessary object: Image, Rectangle,
Rectangle Text or Hyperlink, Button or Frame.
Text
Image Ctrl+1
Rectangle Ctrl+2 Put to Center
Text or Hyperlink Cirl+3 Cover Screen Alt4S
Button Ctrl+4
Frame Ctrl+5 Order '

It's important to note, that there are parents/children relations between objects. As you can see
from the figure above, there are two main or parent objects and several children objects for each
main image. It means, that children objects are subordinated to the parent ones and they have all
features of their parents. If you delete a parent object, all children objects will be also deleted.

With the help of the object list, you cannot only add or delete different objects, but also adjust
them. When right clicking on the object list, you may perform different operations.

As have been said already, you may Add, Delete, Cut, Copy and Paste
Add... [ . .
objects. You may also change the order of the objects.
Put to Center
Cover Screen Alt4S Bring to Front Shift+PgUp
Crder b Send to Back  Shift+PgDn
cut Cirl4 Forward One Ctrl+PgUp
Capy Cirl+C Back One Ctrl+PgDn
Select Al Cirl+A Besides, you may also use keyboards shortcuts for quicker work at your
objects. For better understanding of this option, it is better to experiment
Delete Del with them.
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Timeline Animation

Timeline option is situated below the preview window and contains a number of features.

| | .-
fIEDD ms. 1500 ms. T
[ Create ] [ Preview ] [ Project Options l [ Customize Slide ] [ Tools ] [:]

Here you can see the blue rectangle, which identifies the time of showing a current slide. The blue
line on the left shows the beginning of the slide and on the right - the end of the slide. You can also
see keypoints, which are highlighted in pink. Above the first keypoint there are the figures in blue,
which show the time from the first image up to the current slide. You can add any number of
keypoints to your slide by clicking the button «+» or delete them with the help of the «-» and make
different positions of the slide on the screen. That is one of the uses of timeline option, you can
make various animations with one or more slides. You may also drag these keypoints by left
clicking of the mouse and putting them to the necessary position on the timeline bar. In this case,
the figures above the keypoints will change according to their position.

On the right of the blue rectangle you may also see two buttons with left and right arrows. They
are used to highlight the keypoints and move the blue triangle cursor on the grey bar. You can also
use the mouse for this purpose, but if you have a great number of keypoints, which are near one
another, it is not very convenient to control them manually and it is better to use these two buttons.

Below these buttons you can see one more option Play. With the help of it you can preview the
animation of the current image, but without music background. It is just a quick way to check the
animation and to change it then, if it is necessary. It's important to note, that if you want to have a
look at the whole slide show with music and all effects and transitions, you should use option
Preview. If you want to see the slide show from the current slide, you should use the button nearby
the Preview button.

Below the blue rectangle, where the timing of the slide is shown, you can see the same buttons as
in the Main Window. They are Create, Preview, Project Options and Customize Slide, which
have already been described (see The Control Buttons p. 23).

Beside Customize Slide there is one more option, which have not been described yet, Tools.
When clicking on it, the following dialog box will be opened.

With the help of this menu you can Undo and Redo some
changes and if you don't like your work at all, you can
Undo or Redo All Changes at once.

Unda Ctrl+Z

Undo All Ch , ,
nee Anaes Besides, you can select such options as Show safe TV

zone, where you can see the zone, which you will see on
Show safe TV zone TV; Ignore Objects Not Selected and Hide Selection on
Ignare Objects Mot Selected Alt+ Pan/Zoom/Rotate, which are self-explanatory.
v Hide selection on Pan/Zoom Rotate
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How to create Pan effect
If you want to create Pan effect, you should do the following steps:
m You should select the picture and click Object and Animation in the Preview window.

m Then you should choose Animation tab in the right upper corner of the main window of the
Object and Animation option.

m After that you should set the keypoints on the timeline bar.

T
& | .-=: .-:=

4

T1 500 ms. 1800 ms,
[ Create H Preview ]@ [ Project Options l [ Customize Slide H Tools ]

@ First you should set the keypoint, which is shown in pink and then customize the position
and the size of the slide by dragging it with the help of the mouse or using small blue arrows
in the Animation Tab > Pan.

a The next step is to set another keypoint by dragging the blue triangle, as seen above, to the
necessary position and pressing the button + for adding the keypoint. When you have added
the next keypoint, adjust the position of the slide. That time from one keypoint to another
one, the slide will move from one position to the other one. See the example.

That is one position of the slide on the first
keypoint.

Autumn

This is another position of the second
keypoint.

Autumn

That is how to create panning of the slide, if you want it in your project.
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How to create Zoom effect

If you want to create Zoom effect, do the following steps:

m You should select the picture and click Object and Animation in the Preview window.

m Next you should select Animation Tab in the right upper corner of the main window of the

Object and Animation option.

m Then you can zoom (enlarge or diminish) your image with the help of small blue arrows in
the Zoom tab. You can also do it by dragging the angles of the image with the mouse.

m You can use timeline bar to make animation here.You should set the keypoints on timeline and
adjust the position and the size of the slide in each keypoint. See the example.

< bd

oo | |
1500 ms = 1500 ms. |

\ I

[(create | [_preven | (3] [Prorect optons | B[

< bl
\ [ - . |
‘ Tmuu s & 500 me |
[cieste J[_reven ][] [rroceonters

As you can see from the example,
this is the position of the slide in
the middle of its duration. The blue
triangle is in the middle of timeline
beside the second keypoint.

From that example you can see
the zoomed picture in another
keypoint position. The image can
be adjusted with the help of the
mouse by dragging the angle of
the green rectangle to the
necessary direction. You can also
do this with the help of blue arrows
in the Animation Tab.

On clicking the Preview or Play button, you can see how the animation works.
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Project Options

Project Options are the main options, with the help of which you can adjust your slide show. They
contain several tabs such as Main, Advanced, Music, Comments, Screen, Effects and
Messages Tab. It's important, that all these options are for the whole slide show and not for each

slide.

Main Tab

The first tab in the Project Options is the Main Tab.

Project Options le

Mair |Advanced Music || Comments || Screen || Effects || Messages

Main settings

(%) Create Slideshow (.EXE) () Create Screen Saver (,5CR)

[ Assign icon (*.ico file) for EXE file of slideshow l

[ Customize Startup Window... ] [ show startup window

Pause when window of slide show becomes inactive

Show settings

(%) Close show after last side
() Repeat show until ESC is pressed
(7 When show ends keep last slide in show on screen

Synchronize music and slides

[[] Auto spread slides along music
[pisplay slides in random order
[ wait for a key press or mouse dick to show next slide

Time interval for new slides:

4 +|s and |D ¢| ms ’ Set for existing slides ]

’ oK ” Cancel ” Set Defaults ]

m First in the main settings you should choose
between creating slideshow (EXE file) or
screensaver (SCR file). The default setting is always
EXE file, so if you want SCR file, then you should
change.

m If you want to use your own icon for your slide show,
you should press the button Assign icon (*.ico file)
for EXE file of slideshow and choose the necessary
32x32 or 16x16 icon from your computer.

Assign icon (*.ico file) for EXE file of slideshow g|

[ use your own icon (,ICO file) in Slideshow or Screen saver file

[ Add 32x32icon... ]
[ Add 16x16 icon... ]
[ oK l [ Cancel ]

m Next you can make startup window show, if you want it in your slide show. You can
customize it by clicking on the same button. In this case the following dialog box will appear.

Startup window r'$_<|

Show image:
| i |

Caption:

Author:

E-mail:

| |
| |
Web page: | |
| |
Comments: | |

Show <Help> button
[]show <Exit> button

[ OK H Cancel l

In the Startup window you can set the image, if you
want, by selecting it from your computer. You can also
add some comments and information about the
author of this slide show, if you want. You can mark the
boxes of showing Help and Exit, if you need such
buttons in your Startup Window.

m In the next block Show Settings you can select the
action after the slide show is over and adjust some
other characteristics. You can Synchronize music
and slides, but it is better to do that with the help of
timeline option, which will be described further.

m You may also Display slides in random order. In
this case, the order, which you have in the slide list,
won't be observed.

m You can also select Time interval for new slides,

you may set the necessary number of seconds. It is better to Set this time for existing slides.
In this case, all slides in the slide show will be shown with one and the same period of time.
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Advanced Tab
Here the following options are represented.

m In the Advanced Options section you may
choose the action on the left/right mouse click.
You may choose among seven functions such

Project Options g|
Main | Advanced |Music Comments | Screen | Effects | Messages

R IE I as Exit, Next Slide, Previous Slide, Help,

Mouse buttons [one v |None v First Slide, Pause and no function or None. If

[JExit on mouse move (for screen savers) you Want, you may also Disable the mouse
Disable mouse wheel Disable F1 key wheel.

U = m You may choose to show the mouse cursor or

sec.  [¥]hide cursor at startup hide it at startup by clicking on the box. You

[Z]Pernit control of show using keyboard may also set the time in seconds, after which

the mouse cursor will be hidden. It is important

Customize Navigation Bar... ;
[JShow Navigation Bar |_Customze avgstongar. | to note, that if you move the mouse, the mouse
[JRun application after last side | 3 | cursor will appear again and then will be hidden
after the number of seconds, which you have
Protection of presentation Set Up.
[ show copyright logo [ Customize logo... ]

The next Permit control of show using
[CJEnable time limited usage | customize Trial Use Detais... | keyboard gives you an opportunity to control
| the slide show with the help of keyboard

buttons. For example, you may use PageUp
AL e T e B and PageDown buttons for going to the next
[Jallow to restore pictures (via "Print” button on the Navigation bar) and previous slide. There is a number of
shortcuts, which you may use. It is convenient
Lo J[ concel J[ setoefuits to use them for quicker work, if you know all or
several of them.

|:| Password protection |

m The next button Show Navigation Bar is used, if you want to see it in your slide show. You
may also Customize Navigation Bar by clicking on the button. In this case, the following
dialog box will be opened.

B onie Ny atiessiar = B You_can see two small windows
_ Available and Selected Buttons,
Available buttons: Selected buttons:
[relp First side o] where there are seven buttons,
== AT s which you can select for you
MNext slide ’ y ’ y
ez Navigation bar: First Slide,
Previous Slide, Next Slide,
- Pause, Print, Help and Exit. It is
, - very easy to choose them and their
Position: ml[ Add -> ] [<-Remove] Order. by CIICkIng on them and
T — - —x dragging to the necessary window
e |L50 | AumhldeNa\tlgahonbara.fher. 3 &sec . or USing the buttons Add and
[#] show backgreund Fade in @: Fade out @: ms. Remove beIOW these WindOWS
!Sky style v | Hide Navigation bar at startup

o M _ o . — @ You may also select the position
e = o and the offset of Navigation bar in
the slide show.

@ @ @ @ @ @ If you want, you may Hide

Navigation bar for a number of
seconds, which you can also adjust
with the help of arrows beside the
button. You may also click to Hide
Navigation bar at startup.

N

1



@ You may also choose the style of Navigation bar between Air and Sky Styles. If you want
you may also open other styles in your computer or create them and then open with the help
of the button Styles, which you can find on the right of this dialog box. Besides, you can
show background. To make it, you should click the necessary box with these words.

@ You can also set Scale and Hue of Navigation Bar by clicking on the necessary buttons
and choosing the size and the color. The result of your adjustment you can see below in the
preview box.

m Run application after last slide is the option, which gives you an opportunity to run any
video, picture or object after the end of the slide show. You may add anything you want from
your computer by clicking on the folder icon beside the button.

m In the Protection of Presentation options you can make some settings to protect your slide
show. They are Password, Enabling time limited usage and not allowing to copy pictures
with the Printscreen button. You may also show the logo of your company and customize its
position, size and opacity, if you wish. While customizing Trial Usage Details (usage of the
slideshow), you may set the last date of its usage, the number of runs and even write the
message for other users, why the slide show doesn't work any longer.
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Music Tab in Project Options

With the help of the Music Tab you can add music to the whole slide show.

. o = To add music you should click on the button Add
roject Options LI Music and the dialog box will appear, where you
[Man_| Advanced | Music | Comments | Screen | Effects | Messages can choose the necessary music files from your
Background music for shaw computer. It is important, that you can add several

| — | [(remore |[ oo | files to your slide show. Beside there are two

buttons Remove and Clear. Remove help you to
LT BRI delete one highlighted file from the list. Clear
helps you to delete all files from the list.

You can have a look at music duration of all files
by clicking on the button Show Music Duration,
which is found below the list of music files.

You have an opportunity in this program to Play
songs in random order, if you wish, and to
Repeat music after playing. For this you should
highlight boxes with these settings.

|C: \Documents and Settings‘\All Users\QokymerTer\Mos My3bn(a'|,05p|

If you add sound comments to your slide show,
you can adjust such parameters as Don't
interrupt sound comment when next slide
SlEoommoea appears. If this option is not checked, the sound
[ bon't interrupt sound comment when next side appears comment for the current slide will be played till the
slide is on the screen. When the next slide
appears on the screen, the sound comment is
interrupted. If this option is checked, the sound
comment will be played up to the end.

[Jrlay songs in random order 01:33
Repest music after playing

[ K ” Cancel ” Set Defaults
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Comments Tab

In the Comments Tab you have an opportunity to add some comments to the slide show and
customize it according to your wish.

m In the first part of the tab, which is called

Project Options

Main

Advanced | Music |C'3|TII'ﬂEﬂt5 |5|:reen Effects | Messages

Customize comment font

Size

Do

Line Spacng

Offset:

Position on a slide:

0 v [CEE—

%]
!

Customize comment font, you can select the
font of your comments, Bold, Italic or
Underscore font, Color, Line Spacing, Offset
and the Size of the text. On the right to the font

| H Arial Baltic V| [+] rop shadow
= : adjustments you can select the Position of the

comments on a slide by clicking on the arrow,
where drop-down menu will be opened. You
may set from the variety of choices: on the Left
or on the Right, at the Top or at the Bottom
and so on. You may either

add Drop shadow, if you =ft =

Set for existing slides

Insert template

Set text comment for new slides:

[ Set for existing slides

check it and Customize for
Color, Opacity, Angle, Size
and Spread, if it s
necessary. You shouldn’t
forget to Set for existing
files all your settings.

Top

Right

Bottom
Center
Left-Top
Right-Top
Right-Bottom
Left-Bottom

Autumn

[ oK H Cancel ” Set Defaults ]

m In the second part of the Comments Tab Set
text comments for new slides you may either use comments templates or add new ones
according to your choice. If you click on the button Insert template, the drop menu will be
opened. Here you can choose, what you want, and the necessary information will be added
automatically.

Picture Name

Picture Name {with Extension)
Picture Path

Picture Path (with Extension)
Folder Name

Folder Path

Picture Width

Picture Height

Slide Mumber

Slides Count

JPEG EXIF Description

JPEG EXIF Comments

JPEG EXIF Time

JPEG EXIF Date
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Screen Tab

Screen Tab is divided into three sections: Screen Options, Background and Additional
Options. In the first section you may adjust the images to the screen.

3

Project Options
Main || Advanced | Music || Comments | 5creen | Effects || Messages

Screen oplions 5
Fullscreen

Aspect ratio of a slide

100 % | % of the slide to show main images

[ et for cvictinn didee

I OK H Cancel ” Set Defaults

with

m First you may choose the Fullscreen mode or
Windowed mode. The default is always Fullscreen.
Here you can also set Aspect ratio of a slide
according to your monitor size and form. For normal
monitors and not wide television screens the aspect
ratio is 4:3 PC/DVD. If you want to set another ratio,

: Your display - 4:3 : .
Lol e click on the arrow and the drop-down menu will be
Caption of show Opened i
[¥]Hardw leration (D30) .

S s3ecow  ~ You may choose any ratio from the

kground ! .y .

Backgroun eX|st|ng_ ones, but if you _ need
@ 5old color I : 5:4 PC something different, you may click on
O gradient filing i Custom and set the necessary figures
() Tiled image ' .

16:10 FC manually (See Aspect Ratio p. 46).
Additional Options (scroll down to view) 16:3 DVD
s ptions i o vis (Custom)
Display shadow behind slide image:
[ sctiorexstngaides | The next option Caption of show works only for the

Windowed Mode. If you have chosen Fullscreen
mode, then this option is of no use to you.

Hardware acceleration option should be generally
checked, if you create the show with animations. It
gives you an opportunity to watch your slide show

better quality.

m In the Background Section you may set the background as Solid color, Gradient filling or
Tiled image. You should remember, that if your images fill the whole screen, then this option
is of no use to you. But if the images don't fill the screen, you may select among three
variants, which have been already described earlier (See Customize Slide, Background p.

25).

In the third section Additional Options first you may see Display shadow behind slide

image. If this option is checked on, you can also Customize it.

Additional Options (scroll down to view)

Display shadow behind slide image:

[ Set for existing slides ]

100 % | % of the slide to show main images

[ Set for existing slides ]

[Jpisable scaling of main images (Mot recommended!)

[ Set for existing slides ]

It is important, that this function also works only,
when the image doesn't fill the screen. Don't
forget to click on the Set for existing slides
button to set this option for the whole slide show.
By clicking on the Customize button, you may
select the necessary Color, Opacity, Angle,
Distance from the Image and Size of the
Shadow.

The Percentage of the slide to show main
images is the option, which gives you an
opportunity to watch your slide show at any size
on the monitor.

The option Disable scaling of main images (Not recommended) should be normally unchecked.
The reason is that while playing this show on the other computers when option is checked, the
slides may be shown with different resolutions and the images may be larger or smaller. It is better
not to use this option. Of course, if you want your slide show run at your own resolution, you can

check disable scaling.
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Aspect Ratio

This article will help you to prepare your slide-shows for burning on DVD by using PicturesToExe
and Video Builder. Let's try to explain what the difference between DVD aspect ratio and slide-
show aspect ratio is. DVD aspect ratio sets by Video Builder in Project Options window. Slide-
show aspect ratio sets by PicturesToExe in Project Options -> Screen tab.

Encoding DVD aspect ratio 4:3 - Slide-show aspect ratio 16:9

Here is the example of what happens with slide shows if you encode presentation with 16:9
(800x450) aspect ratio (slide-show aspect ratio) with 4:3 aspect ratio (DVD aspect ratio).

450 px

800 px

top black area

bottom black area
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4:3 TV display example

While viewing this DVD on TV set with 4:3 sides, video will look like encoded before (picture
below).

— — — | 1. Slide-show aspect ratio 16:9.

2. DVD aspect ratio 4:3.
3. TV display aspect ratio 4:3

Bottom hlack area

COC00 » o

¥

v

16:9 TV display example

While viewing this video on widescreen TV display, video will look like with 4:3 aspect ratio. This
means, that TV display will add black areas on the left and on the right sides of the video to make
aspect ratio as 16:9. Look at the picture below.
1. Slide-show aspect ratio
Top black area 16:9.
e
DVD aspect ratio 4:3.

3. TV display aspect ratio 16:9.

Left black area
eade yie|q by
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Encoding Slide-show aspect ratio 4:3

Here is the example of slide show with aspect ratio 4:3. Encoding result of it (DVD aspect ratio 4:3)
will look original without any black areas.

800 px

Encoding result will look the same.

G00px

1. Slide show aspect ratio 4:3.
2. DVD aspect ratio 4:3.
3. TV display aspect ratio 4:3.

This is the example how such DVD will look with 16:9 aspect ratio display.

1. Slide show aspect ratio 4:3.
2. DVD aspect ratio 4:3.

3. TV display aspect ratio 16:9.




Encoding DVD aspect ratio 16:9 - Slide-show aspect ratio 4:3

For example your slide-show has 800:600 pixels dimension (4:3).

800 px I Source slide-show (4:3 aspect
ratio).

GO0px
" 1. Slide-show aspect ratio 4:3.
2. DVD aspect ratio 16:9.

iy 2
s Y
- -
o =
E & 600 px
) £
= o
- P

=]

16:9 TV display example

As you can see 16:9 TV display shows this video as it looks after encoding.

1. Slide-show aspect ratio 4:3.
2. DVD aspect ratio 16:9.

3. TV display aspect ratio 16:9.

Left black area
eaJe yae|q by
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4:3 TV display example

As soon as we try to see this video on the TV display with 4:3 sides we can find black areas at the
top and at the bottom of our DVD. These areas are added by TV display to make video aspect ratio
4:3.

e — 1. Slide-show aspect ratio 4:3.
2. DVD aspect ratio 16:9.
3. TV display aspect ratio 4:3.

Left black area
eade yae|q yybiy

Encoding Slide-show aspect ratio 16:9

Here is the example of source slide-show with aspect ratio 16:9. Encoding result (DVD aspect ratio
16:9) will look original without any black areas.

Source slide-show (16:9 aspect ratio).
- Encoding result will look the same.

450 px

This is the example how such DVD will look with 16:9 aspect ratio display.

1. Slide show aspect ratio 16:9.
2. DVD aspect ratio 16:9.

3. TV display aspect ratio 16:9.
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This is the example how such DVD will look with 4:3 aspect ratio display.

— — 1. Slide show aspect ratio 16:9.
| 2. DVD aspect ratio 16:9.
3. TV display aspect ratio 4:3.

How auto aspect ratio mode works in VideoBuilder

This issue is about how Video Builder auto aspect ratio mode works.

Each of the videos being located on DVD disc may have one of the following aspect ratio: 4:3 or
16:9. VideoBuilder can't burn DVD with slide-shows using different aspect ratio. If you set aspect
ratio 4:3 (VideoBuilder options) in options all presentations will be in 4:3, if you set 16:9

(VideoBuilder options) all of them will be 16:9.

Even if one of all presentations has an aspect ratio, which differs from 16:9 (slide-show aspect
ratio), all of them will be with 4:3 aspect ratio. Only in the case, when all slide-shows have 16:9
aspect ratio will all slide-shows will be in 16:9. Therefore if you create DVD disc for wide width

display there is the reason to set 16:9 aspect ratio for all slide-shows.

Custom aspect ratio slide-show

In case if slide-show has aspect ratio, which differs from 4:3 and 16:9 (for example 5:4) it will fit to

the nearest aspect ratio (see the picture below).

4:3 aspect ratio
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Photos resolution and slide-show aspect ratio

This is the fact, that there is no relation between photo dimension and slide-show aspect ratio. As a
default, the value for slide-show aspect ratio is 4:3 (for new project) and in case, if you add some
photos with 16:9 aspect ratio, the slide-show will not change the aspect ratio automatically. To
change slide-show aspect ratio go to the Project options -> Screen tab and set it manually
according to the dimension of your photos.

Effects Tab

With the help of Effects Tab you can add different transitions between slides and to make your
show animated.

X When checking the box Enable transition

Project Options L. X .
: : effects, all transition effects become highlighted
Main Advanced | Music | Comments | Screen | Effects Messages and yOU may Choose among them |t iS necessary
Transiton effects —— to note, that if you want to see how these effects
[¥]Enable transifion effects ] S work, it is better to experiment with them.
. -~
Fadr::;:linfout The first several effects such as Fade in/out,
Hour hand Hour Hand, Rhombus, Rectangle, Gates, Page
7] Clocknise Effect, Push and Slide Effects and some others
[¥] Counter-dockwise are self-explanatory. Circle effect has one
Circle e peculiarity: you may change the Center here with
ENter: . .
Tocenter ~ M the help of small arrows, which are found beside.
W .
" :mmcemﬂ If you scroll the Effects Tab down, you will see
“::cem such effects as Mosaic, Curling of Page, which
[#] From center should be described.
He“"Tg'e N Mosaic has different appearances and can
o Ccenter . . . .
[7] From center consist _of dllfferent number of pieces, which can
Gates [honzontal/vertical) . move Wlth dlfferent Speed'
Thickness of smoothing line: 6,0 W | %% Mozaic
Effectduration:  |1500 & | mg 200UE1second(s) [ Mosaic
Parts: |8 &% |8 % | Appearance: |10 |
QK C | Set Defaults .
I ocmat J} cciomiai ] You can set any number of pieces. If you want

large pieces, you should set less number of them
and vice versa. If you want small ones, you should select more pieces. It depends only on your
choice, so try to experiment.

Curling of Page can also be different according to the radius, which you choose. To see the
difference, have a look at the examples below.
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As you see, in the first picture the radius is large and on the second one it is small. If the radius is
large, the line is more soothing, if it is small, the line is sharper. Besides, you may also set the color
of the back side as seen from the examples.

As seen in the Effects Tab, you may also set the Thickness of smoothing line and Effect
duration, which is given in milliseconds, by clicking on the small arrows beside the options.

In the first picture the default setting of thickness of smoothing line is 6 %. In the second is 52%.
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Messages Tab

In Messages Tab you can add messages to any parts of your slide show.

Project Options

Captions on buttons

Button <OK>
Button «Cancel>
Button <Run>
Button <Help>
Button <Exit>

Help window

Window caption:

Startup window
Author:
Web site:
E-mail:

Comments:

Password query

Caption:

|OK

|Cance|

|Run

|He|p

|Exit

|He||3

|Auﬂ1c-r

|web site

|E-mai|

|C0mments

|Passw0rd required

X

Main || Advanced | Music || Comments || Screen Effectsl Messages

£

|£

QK

H Cancel ” Set Defaults

There are several sections here: Captions on
Buttons, Help Window, Startup window and
Password query. If you scroll down, you will also
see such sections as Expired Trial and Print
Dialog. All sections are self-explanatory and give
you the necessary information. But it is important
to explain some sections.

In Password query you can add the image, which
tells the user of your slide show to enter the
password.

In Expired Trial you can add a message, saying
why the show cannot be run any longer and give
some instructions what to do further.

The messages are added already by default here.
But if you wish you can rename them by adding
your own information. If there is not enough
space, it does not matter much, you may continue

typing.
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Timeline Operation

If you want to add background music to your slide show, then customize it and synchronize the
slide show to music, you should use Timeline Option, which is found in the Main Window of
PicturesToExe in the Control Buttons panel.

The main function of the Timeline Option is to synchronize a number of slides to music. There are
several ways to do that:

m to auto spread slides along music at equal intervals of time;
m to coincide slides with the certain points in the sound track;

m to coincide slides with the certain points in the sound track not only with music but also with
some commentary.

Some timeline options are represented in the main window menu View. If you click on it, the
following dialog box will be opened.

Dot Use Auto-Scroliing Here you can select the Style of Auto Scroll between Style 1
and Style 2 or Don't Use Auto-Scrolling at all. The difference
between two styles is in the presentation of the synchronization
while watching it on the timeline bar.

Auto Scroll - Style 1
Auto Scroll - Style 2

ZFoom In Ctrl+F11 . . . Lo

7oom Out Ctrl4F12 You can also Zoom the timeline window In or Out by clicking on
these buttons or using shortcuts, which you can see opposite the

Color of Wawveform words.

Display Waveform as... k

You may also choose the Color of the Waveform. By clicking on
it, the dialog box will be opened, where you can choose the
necessary color. Besides, you can select Display Waveform in two ways.

While adjusting your slide show in the Project Options, tick the synchronization of music to the
slides in the Main Tab. If you do this, then in the Customize Synchronization window, the default
is Synchronize music and slides. Besides this, you may tick Auto spread slides along music.
In this case, the timeline window will be greyed out and the slides will be equally distributed along
the whole music track. For example, if you have sound track, which lasts 1 minute, and you have
10 slides in your slide show, then the intervals between the slides will be 6 seconds.

To see the timeline and synchronization window, you should click the button Timeline, and the
following window instead the Slide List will be opened.The timeline window is represented below.

[ mewtransiton || cuttransiton | [ Timedpeints | | 0:00.000 % [ customizeside | [ Objects and Animation | Side 10f8

(=]

1 2 3 4 5 [ 7 T 9 o 11 12 13 14 15 1 17 18 19 20 21 22 23 24 25 2% 27 28 29 30 31 32 33

7Y | T | T T | T
ﬁ to2 o3 to 4 to 5 o6

< ¥
[ Create ] [ Preview ] [ Video ] [ Project Options ] [ Slides ] [ Add ] [Remove Slide ] [ Clear List ] 4*- E

Here you can see slides, which are represented by figures below the line. The figures above the
line indicate the seconds. The beginning of the timeline is zero, the end depends on the duration
of the sound track and may be any number of seconds or minutes. Thick grey lines beside each
slide indicate transition time. You can also see a blue triangle, with the help of which you can go
from one slide to the other one. It is important to note, that you can change the position of the
slides by clicking on a number of the slide and dragging it to the necessary place. Besides this, you
can also change the time of transition by clicking on the end of the grey line and dragging it to the
right or to the left, it depends on whether you want to make transition longer or shorter.
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Now it is necessary to describe the buttons, which are situated above and below the timeline
window.

[ Newtransiton | [ cuttransiton | [ TmedPoints | | 0:33.000 % Customize gide | [ Objects and Animation | slide 9 of 9

[ Create ] [ Preview ] [ Video ] [ Project Options ] [ Slides ] [ Add ] [Remove Slide ] [ Clear List ] 4" El

m b Play button is situated above the options Customize slide and Objects and Animation in
the Preview window and is used to begin the preview of your slideshow in a small preview
window in the right upper corner. This button plays two roles: Play and Pause. If you click on
Play it will turn u Pause and vice versa. When you click on Play, the blue triangle will stand

at the beginning of the timeline and will move to the right on the bar.

" om . 00:34.501 I o037

[ Customize Slide ] [ Objects and Animation ] Slide 9 of 9

m As you can see from the figure above, next to the button Play/Pause there is another button
labeled Stop. You should remember, that if you click on Stop and then on the Play button, the
preview will start not from the beginning, but from the place where the cursor was situated. If
you want to watch the preview from the beginning, you should do the following:

@ Click Play for previewing the slide show;
@ As soon as Playback begins, click Pause;
@ Drag the blue triangle to the beginning and click Play once again.

m New transition is the option, which gives you an opportunity to add new keypoints in the
desired place on your slide show and timeline. It is important to know, that for adding the
keypoint you should set the blue rectangle to the necessary place on the timeline bar and then
click on the button New transition. The slides and their transitions will be moved from their old
places to new ones.

m If you want to delete the keypoints you should use the option Cut transition. But you should
remember, that the keypoints will not be deleted, but just moved to the end of the slide show. If
you press the button New transition in this case, the keypoints, which were deleted earlier,
will be moved to their previous places.

m Next option Timed Points includes the following functions:

@ Arrange All Points helps you to set all points on
the timeline bar in the equal intervals of time
along the sound track.

Arrange All Points

Cut All Transition Points Ctrl+alt+H
Shift Points... Ctrl+H
Set Time of Points... Shift-+Ctrl+T

Set End of Last Slide at End of Music

Import Points from Another Project...
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a Arrange Selected Points is greyed out, because there are no selected keypoints. But if you
select some points, this option will be highlighted and you can use it. It functions in such a
way: you should select the necessary keypoints and then click Arrange Selected Points. In
this case, all selected points will be set at equal intervals of time. Of course, you can do this
manually, but it is much easier to set them automatically.

e 23 3 48 Be Bs Vs Bs 9 10z 1z 12¢ |13z 14z 15 16s 17 18s

O X 0 R A 1 ) R AR, e
f T ! F Y ' ' I T
1 o 2 o ¥ o &

@ Cut All Transition Points is the option, which helps you to delete all keypoints and then to set
new ones.

@ Shift Points is the option, which gives you an opportunity to move all or selected points to the
necessary direction, to the right or to the left on the necessary number of seconds. For doing
this you should select the keypoints and click Shift Points. In this case the following dialog
box will be opened:

% Here you can Choose Direction, where
Shift Points... LIl to shift the points, the first arrow gives
you an opportunity to shift to the left, the
second one — to the right.

e e
B w|s and |0 | M8 Then you can set a number of seconds

and milliseconds, on which you wish to
shift the points.

After that, click OK and see the result.

Choose Direction

o [ oo

a Set Time of Points is the option, which gives you an opportunity to set all the slides or just
selected slides at the intervals, time which you can set manually. To do this, you should select
the slides, if you need, and click button Set Time of Points. In this case, the following dialog
box will be opened:

m Here you can set a number of milliseconds, which the
Set Time of Points... L238  slide will be shown in the slide show.

Specify time in miliseconds:

4000}

[ Ok ] ’ Cancel

@ Set End of Last Slide at End of Music is the option, which by clicking on will set the end of
last slide with the end of music track notwithstanding with its duration. You should remember,
that only the last slide will be prolonged for the necessary number of seconds or minutes,
other slides will not be moved. It is important to know, that in this version you have an
opportunity to move the end of last slide on the timeline bar. In previous versions this option
was unavailable. You may drag it with the help of the mouse to the desired direction, to the
right or to the left.

@ Import Points from Another Project is the option, which can be very helpful, if you don't
want to make a new timeline. You may just import points. To do this, you should click this
button and then choose the project, from which you want to import the keypoints. It is
important to know, that the number of slides in these two projects should be equal.
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m Next to Timed Points you can see a small box with numbers, which show the time of

0:24.000 % the chosen slide in the timeline bar.

m The first buttons below the timeline bar is Create, Preview, Video, Project Options were
explained earlier.

m Options Add, Remove Slide, Clear List are related not only to the Slide List, but also to the
Timeline. It depends on what you are adjusting. With the help of these options you can Add
slides to the timeline, Remove one or more slides and Clear List. In the last case, all the
slides will be deleted from the timeline and you can set a new timeline, if you wish.

m Next to these three options you can see the button, which is called Waveform. Clicking on it,
you will see the waveform of the sound track on the timeline bar. It is important to
-#M-  know, that the waveform will appear only if the soundtrack is added.

Ts 28 3% 4 By B Fs Bs 9s M0 s 12: 13 14: 18: 1B 17 18: 19: 20 s 22¢ 23 24¢ 25e 26s 27: 28: 29: 2

f ' f ' f ! | ' 5 ' f ' f ! f !
1 ta 2 o3 to 4 @ to? to 8 ta 9 ta 10

o — mem————y

m It is necessary to note, that you can adjust the color of the waveform in the View Menu >
Timeline Options. Besides, you can select the Display of the waveform in two ways.

 Mixed channels The difference is only in the way of presentation the waveform. In the
Left and Right channels example above you can see the waveform with Mixed channels.
Below you can see the example with Left and Right channels.

1 2¢ 3= 4¢ By Bs Yz Bz 8 10z Me 12¢ 13z 14 15 16s 17 18 19 20s 21 22¢ 23s 24 25 2ZBe 2¥s 2B 29: 3

O A ., T e e e
f ' f ' f ' f ' F 3 ' f ' f ! f !
1 to 2 to3 to 4 $ ta 7 to 8 ta 9 ta 10

T ey

After having adjusted all these options, you can see the result either by clicking button Play (in this
case, you may see the slide show in a small preview window) or by clicking button Preview (in this
case you may see the slide show fullscreen).

[ El The last and next to waveform option and icon gives you an opportunity to have a look at
chosen images in the standalone window. On clicking this button you will see the following
window:

=~ Here you can see all images,
which you have added to your
slide show. Below the images you
have the option, which gives an
opportunity to observe images with
names or without them. Next to
this option you can see the bar,
which can be regulated manually
to zoom images. In previous
versions this option wasn’t
available in the timeline operation,
it could be used only in the slide

4. IMG_5523.bmp 5. IMG_5593.bmp 6. IMG_7685.i0g I |St
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Side 10f8 Srenamro c u}

2. IMG_i046.jpg 3. IMG_5510.bmp




Video Options

If you have a look at the Control Buttons, you will see Video button. When clicking on this button,
you will see the window, where you can select between DVD-Video or AVI file.

Video output

(See Main menu | View | Advanced options)

[ Burn DVD-Video disc l ’ Create AVI file l

Video Builder (DVD video disc)

If you choose to create DVD-Video in Video button, another program, which is called Video
Builder, will be opened.

€ Untitled - WnSoft Video Builder 5.5

File Edit Help |
sB-+= = o —
(=8} - A~
-{23) ABBYY Lingvo 1 B
{C3) Agnitum
{22 Alwil Software
{3 Borland
{C3) Commeon Files b
{3 D-Todls
{2 Google
{C3) HTML Help Workshop
£ 1cQs L ABBYY Lingvo Agnitum Alwil Software
{3 Internet Explorer
LD Java
{2 JavaSoft
{3 Luxor =

) Messenger

{3 Microsoft ACT

++{[3) Microsoft ActiveSync

i--{[3) Microsoft Chat

{C3) microsoft frontpage

{3 Microsoft Office

{3 Microsoft Visual Studio JNET 20
{3 Microsoft Windows Small Busine
{3 Microsoft.NET

{C3) Movie Maker

{C3) MSN Gaming Zone = \ = \

{7 NetMesting Add ][ Remave ” Clear ]

Borland Common Files D-Tools Google

[I£9
|i<

|~
|

1. Autumn.pte

Project options [¥]createmenu |DVD 4.7 % I34 MB [ 00:00:39 Bac

Modified Selected files: 1 C:'\Program Files\,

At the upper left corner of the main window there are three main menus: File Menu, Edit Menu,
Help Menu.
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File Menu
When clicking on the File Menu, the following drop menu will be opened.

Here you can make a New file, Open other files, Save and Save As

Mew. .. Cirl+M

= your work, Burn ISO image: when clicking on the Burn ISO image,
Open... Cul+0 the following window will appear.
Save Ctrl45

Save As... Shift+Cirl+5
Burn IS0 image...

Exit

The Burning Options are Device, with the help of
which you will burn, Speed, chosen by you, Label and

¢ Burn ISO image

the last, you should choose the place for ISO image on | """ .

your computer. Then click Burn ISO or Cancel, if you | o == "

don't want to do anything here. -

It is important to note, that ISO image is a special file, 2007_12_27

which is used to run the project, which you burn on the 150 image:

disc, without this disc. (=]
Burn ISO ] ’ Cancel

Edit Menu

With the help of this menu you can perform some operations with the projects.
Add You can Add or Remove projects, Clear the entire project list at all,
— Del Move to the Left or to the Right from one project to the other. You can

also see File Info. If you click on the File Info, the following window will

Clear be opened.
Move to left
Move to right

File info... Ctrl+U

Here you can see the information about the chosen project: File Name, the place, where it is
situated on your computer, the Duration of the sound track, the Size, the Date of creation and
Aspect Ratio as it would be seen from the monitor. In

Glelik 3 personalized settings you can choose Video Type, the default
e e is Auto always, and you can also choose whether to check Anti-
Foder: | Flicker filter or not.

Duration: 00:01:15

Size: 32,6 Kb

Date: 2007-12-27 14:55:22
Aspectratio: 4:3

Personzlized settings

[[Juse personalized settings

Help menu gives you hyperlinks to the official PTE site, where you can find any information about
this programs and ask questions, if you have any.
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Below the main menu there is the drive selector, where you can choose the necessary drive.

D8RR

= 5

As seen from the figure above, drive X is chosen.

Below the drive selector, you can see the file directory tree of the chosen drive. Nearby there is
the preview window for a selected file or project. Below the preview window you can see the
same buttons as in the Edit Menu: Add, Remove and Clear. Then the project list is situated,
where the chosen projects can be seen and their duration and size are shown below in a special
box, shown below. Red vertical line indicates the end of free space on the disc.

W55 MB /00:01:15

On the left from this box there are several options, which should be described. The main of them is

Project Options.

Options
Project | Program

Video options (720 x 5746, 25 fps)

[+] Anti-flicker filter (for slide show

Bitrate:

Advanced options

[ |Repeat playbadk of a disc
[Jreturn to menu after each title

Add chapters

TV system: PAL [ SECAM
Menu aspect ratio: 4:3
Titles aspect ratio: Auto
Bitrate: F00a
Video Type: Auto

s)

Audio options (MPEG audio, 48 KHz, Sterea)
Audio format: MPEG Audio

224

1

X

<

4

kbps

w | kbps

4

mir

Set Defaults

OK

H Cancel ]

In the Project Tab of the Options there are
several sections. In Video options first you
should choose TV system according to the
country you live in. There are two systems:
PAL/SECAM is used in the Europe and NTSC
is used in the North America, Japan and some
other countries.

Next you can choose Menu and Title aspect
ratio. The default for Menu aspect ratio is 4:3
for ordinary televisions, but you may also select
16:9 if you have new televisions such as LCD
or flat panel TV screens. The Aspect ratio for
them differs from the old ones. The default of
Title aspect ratio is Auto, but you may also
select 4:3 or 16:9. You should remember, that it
is the aspect ratio not for your slideshow, but
only for the menu and title.

Next you can choose Bitrate, the default is
7000 kbps, but if you have the necessity, you
can change this figure.

The next Video Type can be also changed.
There are two types of them: Interlaced and
Progressive. The default is Auto, that is
Interlaced. But if you have a new TV, such as
LCD or flat panel televisions, you'd better
select Progressive video type.

m In Audio options you may select the necessary Audio format and its Bitrate. Here it is better
to use default settings to avoid a bad quality sound track.

m In Advanced Options you can customize such settings as to Repeat playback of a disc or
not, to Return to menu after each title or not. You can also add chapters to your DVD-disc
and set the number of minutes for each chapter.

m In the Program Tab you can choose the place for the temporary file of your project.

Project | Program

[ 1dle priority
Temp folder:
C:\Temp
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m The next buttons are Set Defaults, OK and Cancel, which are self-explanatory.

Nearby the Project Options button you can see several options.

Project options Create menu | iGN v ﬁs MB f00:01:15 I

You can check Create menu box, if you want the menu on your DVD-disc. Next you can choose
the size of your DVD, the default is 4.7, but if your disc is larger or smaller, you can choose two
other parameters 8.5 and 1.4. Next you can see the bar, which shows the total space on the disc,
as has been said above. Here you can see the blue color, which indicates the space occupied,
and the white color, which indicates the free space. The red line shows the end of the free space
on your disc. At the end of the bar, there are two buttons: Back, which is greyed out, and Next,
which are self-explanatory. Next gives you an opportunity to go forward and Back - backwards.

& Untitled - WnSoft Video Builder 5.5

File Edit Help }

Choose
Template

Deep in the
ocean

Items: |2x 1 v

Hue, Saturation, Lightness...

[ Background image

Animated menu

i E]|
Menuduration 10 5] s
[

1. Autumn
|:|Music
|
[ovo 47 v J34me fomonizs I < Back H et > |

Modified

When you have selected the projects, which you want to burn, it is necessary to click Next button
and the window which is shown above will be opened. Here you can customize the menu for your
DVD-disc, if you wish. You should remember, that if you don’t check the box Create menu in the
previous window, this window won't be opened and just the next one will be opened at once.

It is important to note, that the word Title can be changed by clicking on it and typing the
necessary words.

m First you should choose the background for your menu. There are several templates, to have
a look at. You should click on the picture and you will see the following window.
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Here you can see the templates and choose among them. At the bottom of the window you can
see two buttons Add template and Organize templates. The first one gives you an opportunity to
add any image or photo from your computer. The second one helps you to choose the order of the
templates and rename or delete the images. For better understanding have a look at the figures

below.

Organize templates E|
i OK
Pecp n e ccer)
[Silver]
[The green fantasy]
“R-N-a-R-] e W b &
White theme Fictures Burning bridges

[Pictures]

Red douds

[ Add template. .. l ’ Organize templates. .. ]

m Next you may choose the number of items and their location on the menu window.

Tterns: | 4% 2 The more items you want to add, the less size they are. The
' location of them also depends on the number of the projects you

Hue, 53 ﬁ i have added. It is better to experiment for better understanding of

Ix1 the difference.

2x2
Ix2

m Then you can customize Hue, Saturation and Lightness. When clicking on these words, the
following window will be opened.

The default position is represented here, but you

enu colors B may adjust everything according to your wish by
N | moving the cursors to the right or to the left.

- - I =

Hue D

- J

Saturation D

- J

Lightness IZ'

- J

o [ ]
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m You can also see two options Properties and Select Frame, which are greyed out. To
highlight and customize them you should click on the project in the menu window. When
clicking on the Properties, the next window will appear, where there are two tabs: Property

and Drop Shadow Tabs.

Property

Properties | Drop Shadow

X)

Position: |55 2| x |12

Fs
w

size: (131 3| x |98

Fs
w

Opacity: |

O0— 7]

I OK

H Cancel ]

Property El
Properties | Drop Shadow |
Drop Shadow Enabled
Color:
Opscty: ———~
Distance: |_] IZI
‘ Spread -

’ Drop shadow templates "]

[ OK H Cancel ]

In the Property tab you may set the position and the size of the project window by clicking on the
small blue arrows. You can also customize Opacity, if you wish.

In the Drop Shadow Tab you can add and customize shadow to the project window, if you wish.
You may adjust the color, opacity and Angle of the shadow, distance from the window, size and
shape of it. You may also add some shadow templates to your wish.

& Select video frame

[«](»]

==
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In the Select frame option you can choose
the picture, which you want to see in the
project in the menu window.You can scan the
project with the help of the Play button and
stop at the necessary image. This image will
be represented in the project window.



m After that you can choose background image and customize it. When clicking on the folder
beside this option, the window will appear and you may select the image from your computer.
When clicking on the Customize button, the next window will be opened.

Here you can select the location of the background:
tiled, centered and so on. The examples are given in
the figure beside. You may also choose background
color, but you should remember, that you will see it
only if the image doesn’t occupy the whole screen.

Background property

Badkground color:

Cox [ o= |

m Next you can customize Animated Menu and Menu Duration. The default duration of the
menu is 10 seconds but you may set the time you wish with the help of small blue arrows
beside.

m The last point here is adding music. If you want music with your menu, you should check the
box and the option will be highlighted. Clicking on the folder, you may choose the sound track
from your computer and then customize it.

Above the preview window you can see the arrows of different form. The first two mean Previous
and Next Page. 4l I»

They are greyed out in our example as we have only one project. If you have more than one
project, in this case, you will have more than one page and the suitable buttons will appear on the
menu.

The next two buttons Redo/Undo give you an opportunity to make some changes, if you want to
correct something in your menu. 9 ¢

Nearby Redo/Undo buttons you can see the Scale button, with the help of which you can change
the size of the preview window, if you want to customize it and you need another scale. The default
is Auto. But you may select from 10% to 500% of the screen.

As you can see from the figure below, the preview window is surrounded by dark blue rectangle,
which shows safe TV zone.

1. Autumn

3 @@ O®S

1. Autumn

nw @@® O S

65



In the first picture you can see this rectange which determines the zone you won't see on your TV.
In the second picture you can't see this zone, you just see the whole picture on you monitor. It is
recommended to show TV safe zone, because it is more convenient to adjust your menu watching
this zone. But if you want to switch this option off for some reason, then you should right-click on
the menu and the following box will be opened.

This dialog box is the same as Edit menu of this window. So you
have two ways of opening it: by right-clicking on the preview
window and by clicking on the Edit menu in the left upper corner of
the main window.

v | Apply changes for each page

You can see several options here, almost all of them have been

Show safe TV zone described already.

Apply changes for each page is the option, which helps you to

Mext Page make all changes very quickly. If you have more than one project
and more than one page in the menu and you have done some

Select frame changes on the first or second page, for example, you can click on

Properties... this option and these changes will be applied for all pages.

After adjusting this window, press the button Next to go to the next step.

When clicking, the following window for burning the disc will be opened.

Project name

Untitled

[Jcreate MPEG2 Files

Create DVD folders

=
Create ISO image
C:\Documents and Settings

Burn DVD disc
Device: Speed: Label:

E: GenericDVD-ROM 1.0 ~ | | | |Autumn

[ indude additional folders and files to disc

m First you can enter the name of your project. In our example the project is untitled, but in
your project you can click on this word and enter any name you wish.

m If you wish you can create MPEG2 Files, DVD Folders and an ISO image of your project.
Check the boxes and just choose the folders for them on your computer.

m In Burn DVD disc option the device and the speed of burning is determined automatically. Of
course, if you have several burning devices, you can choose among them.

m You may also include any additional folders and files to the disc, if you want. For doing this,
you should check the box and by clicking on the folder select the files from your computer.

Once you have done all this, press the Start button in the right lower corner of the window.
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Create AVI video file

If you want to create an AVI video file instead of a DVD video disc, you should choose this button

in the following box, which will appear, if you click Video button in the Control buttons.

(See Main menu | View | Advanced options)

Burn DVD-Video disc l ’ Create AVI file l

When clicking this button Create AVI file, the following dialog box will be opened.

ER Making of AVI video file

m First you can select what file or disc
to create. If you want to create an AVI
video file, first you should make

(¥ Create custom AVI video file Audio codec ] [ Video codec ] some adjustments. But if you want to
O VeD disc Width  Height FPS select among other variants, you'd
) sveD disc 768 576 7 better understand the difference

) DVD-Video disc between them.

(O HD-1080 @ VCD (also called video CD, video
") HD-1280%720p 50 FP5 _ compact disc or "disc") is a format
[¥1For Uead DVD MovieFactory specifically designed to hold

[] smart anti-flicker filter MPEG-1 video data and to include

Sound fading (500 % | ms. Interlaced video W interactive capabilities. VCD has a
resolution similar to that of VHS,

o Sl [amen)[emm )| MR ar shonof e resouton

holds 72-74 minutes of video and
the bit rate is 1.44 Mbps. VCDs can be played on a VCD player connected to a television
set (in the same way that video cassettes can on a VCR) or computer, on a CD player, on
some CD-ROM drives and some DVD players.

SVCD disc (the Super Video CD) standard upgrades the Video-CD format. It has better
Video and Audio quality. It also includes extensions for surround sound multi-channel audio,
and provisions for PC playback. It's also based on variable bit rate (VBR) MPEG-2 coding for
more efficient use of disc capacity.The bit rate is up to 2.6 Mbps.

DVD-Video disc (Digital Video Disc) is a popular optical disc storage media format. Its
main uses are video and data storage. Most DVDs are of the same dimensions as compact
discs but store more than 6 times as much data. The capacity is from 4.7 Gb on a single-
sided single-layer disc up to 8.54 Gb on a single sided double-layer disc.

HD-1080p (High Definition) is the name for a category of display resolutions. The number
"1080" represents 1,080 lines of vertical resolution, while the letter p stands for progressive
scan (meaning the image is not interlaced). 1080p is considered a HDTV video mode. The
term usually assumes a widescreen aspect ratio of 16:9, implying a horizontal resolution of
1920 pixels. This creates a frame resolution of 1920x1080 or 2,073,600 pixels in total. The
frame rate in Hertz can be either implied by the context or specified after the letter p, such as
1080p30, meaning 30 Hz.

HD-1280x720p is another high definition format. The difference with the previous format is in
the number of lines.

It is important to note, that when changing the format, the window will also be changed. It depends
on the number of programs, which support this format. If the program doesn’t support the

particular format, it is greyed out for that particular format.
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m Next you should choose TV system parameters, if you select one of 5 formats, except AVI
video file. If you live in Canada, the USA, or Japan, you should select NTSC. If you live in
Europe, select PAL/SECAM.

m The default of Sound Fading is 500 ms., but if you want you may change it.

m After that, if you want, you may choose Audio and Video codecs. Codec is a special device,
which is used to compress data. In this case, music (audio) and video. It is important to note,
that the quality of sound and video is not changed; only their size is reduced. When you press
the buttons Audio and Video Codec, you can select the necessary program for compression
manually, but the program always does it automatically.

m The next three windows here denote the number of vertical and horizontal lines and the
number of frames per second (FPS). You can also change it manually, but it is better to set
the default settings here.

m You may see the preview button here and set the time (the number of seconds), which you
want to preview. The default is 10 seconds here.

m At last you should press Create AVI or Cancel, if you don’t want to create anything.

m When you press the Create AVI button, the dialog box for saving it will be opened and after
that, the following dialog box will be opened.

BR Making of AVI video file FEX

Creating of AVI file

Encoding: Audio 0004

(N ]

Cancel

When creating process is finished, burn this AVI file on the disc.
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Hotkeys

F1 - Help

F2 — Rename

F3 — Fullscreen View (File Panel)
F4 — Fullscreen View (Slide List)
F5 — Preview

F7 — Create Screensaver...

F8 — Create Slideshow As...

F9 — Create Slideshow

F10 — Exit

Alt+B — Create Backup in ZIP
Alt+F — Rotate counterclockwise
Alt+] — Ignore Objects Not Selected
Alt+R — Random Order

Alt+S — Replace Main Image

Shift+F1 — Burn DVD-Video Disc...
Shift+F2 — Create AV file...
Shift+PageUp — Bring to Front
Shift+PageDown — Send to Back

Ctrl+1 — File Panel as Thumbnails
Ctrl+2 — Slide List as Thumbnails
Ctrl+3 — Text or Hyperlink

Ctrl+4 - Button

Ctrl+5 — Frame

Ctrl+F1 — Classic View
Ctrl+F2 — Horizontal View
Ctrl+F3 — Vertical View
Ctrl+F4 — File Name
Ctrl+F5 — File Extension
Ctrl+F6 — File Date
Ctrl+F7 — File Size
Ctrl+F8 — Unsorted File
Ctrl+F9 — Create Slideshow and Run
Ctrl+F11 — Zoom In
Ctrl+F12 — Zoom Out

Ctrl+A — Select All Pictures



Ctrl+B — Objects and Animation
Ctrl+C — Copy Slide

Ctrl+D — Add All Pictures to Slide List
Ctrl+E — Manage Templates

Ctrl+F — Rotate Clockwise

Ctrl+G — Show Tree

Ctrl+H — Shift Timeline Points

Ctrl+L — Timeline

Ctrl+M — Set Comments on All Slides
Ctrl+N — New

CtrI+O — Open

Ctrl+P — Project Options

Ctrl+R — Start Preview from the Current Slide

Ctrl+S — Save

Ctrl+Shift+S — Save As...

Ctrl+T — Set Time of Points
Ctrl+U — Customize Current Slide
Ctrl+U — File Info

Ctrl+V — Paste Slide

Ctrl+W — Open Picture

Ctrl+X - Cut
Ctrl+Y — Redo
Ctrl+Z — Undo

Ctrl+Home — Move to Top
Ctrl+End — Move to End
Ctrl+PageUp — Forward One
Ctrl+PageDown — Back One

Ins — Add Keypoint Here
Ins — Clone Keypoint

Ins — New Transition

Del - Delete
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Glossary of Necessary Terms

«A»

Animation is the rapid display of a sequence of images of 2-D artwork or model positions in order
to create an illusion of movement. It is an optical illusion of motion due to the phenomenon of
persistence of vision, and can be created and demonstrated in a number of ways. The most
common method of presenting animation is as a motion picture or video program, although several
other forms of presenting animation also exist.

Antialiasing is the technique of minimizing the distortion artifacts known as aliasing when
representing a high-resolution signal at a lower resolution. In the image domain, aliasing artifacts
can appear as wavy lines or bands, or moire patterns, or popping, strobing or as unwanted
sparkling; in the sound domain, as rough, dissonant, or spurious tones, or as noise. Anti-aliasing is
used in digital photography, computer graphics, digital audio and many other domains.

Aspect Ratio of a two-dimensional shape is the ratio of its longer dimension to its shorter
dimension. The aspect ratio of an image is its displayed width divided by its displayed height.

Audio Codec is a hardware device or a computer program that compress/decompress digital
audio data according to a given audio file format or streaming audio format. The term codec is a
combination of 'coder-decoder'. The object of a codec algorithm is to represent the high-fidelity
audio signal with minimum number of bits while retaining the quality. This can effectively reduce the
storage space and the bandwidth required for transmission of the stored audio file. Most codecs
are implemented as libraries which interface to one or more multimedia players, such as XMMS,
Winamp or Windows Media Player.

Audio format is a medium for storing sound and music. The term is applied to both the physical
recording media and the recording formats of the audio content — in computer science it is often
limited to the audio file format, but its wider use usually refers to the physical method used to store
the data.

AVI-file (Audio Video Interleave) is a multimedia container format introduced by Microsoft as part
of its Video for Windows technology. AVI files can contain both audio and video data in a standard
container that allows synchronous audio-with-video playback. Like DVDs, AVI files support multiple
streaming audio and video, although these features are seldom used.

«B»

Background or desktop picture, is the image or colour displayed on a website or computer
desktop behind the visible content.

Bitrate is (sometimes written bit rate, data rate) is the number of bits that are conveyed or
processed per unit of time. Bit rate is synonymous with data rate.The bit rate is quantified using the
'bits per second' (bit/s or bps) unit, often in conjunction with a S| prefix such as kilo- (kbit/s or
kbps), mega- (Mbit/s or Mbps), giga- (Gbit/s or Gbps) or tera- (Tbit/s or Tbps).

«C»

CD (Compact Disc) is an optical disc used to store digital data, originally developed for storing
digital audio. The CD, available on the market since late 1982, remains the standard playback
medium for commercial audio recordings to the present day. Standard CDs have a diameter of 120
mm and can hold up to 80 minutes of audio. There are also 80 mm discs, sometimes used for CD
singles, which can store up to 24 minutes of audio.

Comment in PicturesToExe is the text, which appears during the showing of images.
«D»

Duration is an amount of time or a particular time interval.
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DVD video disc (Digital Video Disc) is a popular optical disc storage media format. Its main
uses are video and data storage. Most DVDs are of the same dimensions as compact discs but
store more than 6 times as much data. The capacity is from 4.7 Gb on a single-sided single-layer
disc up to 8.54 Gb on a single sided double-layer disc.

«E»
Effect in PicturesToExe is any comment, transition, animation, pan, zoom and so on.

EXE-file is the common filename extention for denoting an executable file (a program) in different
operating systems. Besides the executable program itself, many EXE files contain other
components called resources, such as bitmaps and icons which the executable program may use
for its graphical user interface.

«F»

File is a block of arbitrary information, or resource for storing information, which is available to a
computer program and is usually based on some kind of durable storage. A file is durable in the
sense that it remains available for programs to use after the current program has finished.
Computer files can be considered as the modern counterpart of paper documents.

FPS (frames per second) is frame rate, or frame frequency, the measurement of the frequency
(rate) at which an imaging device produces unique consecutive images called frames. The term
applies equally well to computer graphics, video cameras, film cameras, and motion picture
systems. Frame rate is most often expressed in frames per second (fps) or simply hertz (Hz).

«H»

Hardware Acceleration is the use of hardware to perform some function faster than it is possible
in software running on the normal. Normally, processors are sequential, and instructions are
executed one by one. Various techniques are used to improve performance; hardware acceleration
is one of them. The main difference between hardware and software is concurrency, allowing
hardware to be much faster than software. Hardware accelerators are designed for computationally
intensive software code. Depending upon granularity, hardware acceleration can vary from a small
functional unit to a large functional block like motion estimation in MPEG2.

HD-1080 (High Definition) is the name for a category of display resolutions. The number "1080"
represents 1,080 lines of vertical resolution, while the letter p stands for progressive scan
(meaning the image is not interlaced). 1080p is considered a HDTV video mode. The term usually
assumes a widescreen aspect ratio of 16:9, implying a horizontal resolution of 1920 pixels. This
creates a frame resolution of 19201080 or 2,073,600 pixels in total. The frame rate in Hertz can
be either implied by the context or specified after the letter p, such as 1080p30, meaning 30 Hz.

HD-1280x720p is another high definition format, the difference with the previous format is in the
number of lines.

HSL is a related representation of points in an RGB color space, which attempt to describe
perceptual color relationships more accurately than RGB, while remaining computationally simple.
HSL stands for hue, saturation, lightness. HSL describes colors as points in a cylinder, whose
central axis ranges from black at the bottom to white at the top with neutral colors between them,
where angle around the axis corresponds to «hue», distance from the axis corresponds to
«saturation» and distance along the axis corresponds to «lightness».

«I»

Icon is (from Greek elIkwyv, eikon, "image") is an image, picture, or representation; it is a sign or
likeness that stands for an object by signifying or representing it, or by analogy, as in semiotics; by
extension, icon is also used, particularly in modern popular culture, in the general sense of symbol
— i.e. a name, face, picture, edifice or even a person readily recognized as having some well-
known significance or embodying certain qualities.
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ISO Image (.iso) is a disc image of an ISO 9660 file system. ISO 9660 is an international standard
originally devised for storing data on CD-ROM. More loosely, it refers to any optical disc image. As
is typical for disc images, in addition to the data files that are contained in the ISO image, it also
contains all the filesystem metadata, including boot code, structures, and attributes. All of this
information is contained in a single file. These properties make it an attractive alternative to
physical media or the distribution of software, that requires this additional information as it is simple
to retrieve over the Internet.

«J»

JPEG is a commonly used method of compression for photographic images. The name JPEG
stands for Joint Photographic Experts Group, the name of the committee that created the
standard. JPEG is distinct from MPEG (Moving Picture Experts Group), which produces
compression schemes for video. The JPEG standard specifies both the codec, which defines how
an image is compressed into a stream of bytes and decompressed back into an image, and the file
format used to contain that stream. The compression method is usually lossy compression,
meaning that some visual quality is lost in the process and cannot be restored, although there are
variations on the standard baseline JPEG that are lossless. There is also an interlaced
«Progressive JPEG» format, in which data is compressed in multiple passes of progressively
higher detail. This is ideal for large images that will be displayed whilst downloading over a slow
connection, allowing a reasonable preview after receiving only a portion of the data. However,
progressive JPEGs are not as widely supported.

«L»

Lossless Compression is a class of data compression algorithms, that allows the exact original
data to be reconstructed from the compressed data. This can be contrasted to lossy data
comression, which does not allow the exact original data to be reconstructed from the compressed
data. Lossless data compression is used in many applications. For example, it is used in the
popular ZIP file format and in the Unix tool gzip. It is also often used as a component within lossy
data compression technologies. Lossless compression is used when it is important that the original
and the decompressed data be identical, or when no assumption can be made on whether certain
deviation is uncritical.

«M»

Midi (Musical Instrument Digital Interface) is an industry-standard protocol that enables
electronic musical instruments and other equipment to communicate, control and synchronize with
each other. MIDI does not transmit an audio signal or media — it simply transmits digital data
"event messages" such as the pitch and intensity of musical notes to play, control signals for
parameters such as volume, vibrato and panning, cues and clock signals to set the tempo. As an
electronic protocol, it is notable for its success, both in its widespread adoption throughout the
industry, and in remaining essentially unchanged in the face of technological developments since
its introduction in 1983.

Mode is a distinct setting within a computer program or any physical machine interface, in which
the same user input will produce perceived different results than it would in other settings. The
best-known modal interface components are probably the Caps Lock and Insert keys on the
standard computer keyboard, both of which put the user's typing into a different mode after being
pressed, then return it to the regular mode after being re-pressed.

MPEG-1 defines a group of Audio and Video (AV) coding and compression standards agreed upon
by MPEG (Moving Picture Experts Group). MPEG-1 video is used by the Video CD (VCD)
format and less commonly by the DVD-video format. The quality at standard VCD resolution and
bitrate is near the quality and performance of a VHS tape. MPEG-1, Audio Layer 3 is the popular
audio format known as MP3.

MPEG-2 is a standard for "the generic coding of moving pictures and associated audio
information". It describes a combination of lossy video compression and lossy audio data
compression methods, which permit storage and transmission of movies using currently available
storage media and transmission bandwidth. MPEG-2 is widely used as the format of digital
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television signals that are broadcast by terrestrial (over-the-air), cable and direct broadcast satellite
TV systems. It also specifies the format of movies and other programs that are distributed on DVD
and similar discs, such as TV stations, TV receivers, DVD players and other equipment are often
designed to this standard. MPEG-2 was the second of several standards developed by the Moving
Pictures Expert Group.

«N»

Navigation Bar (also known as links bar or link bar) is a subregion of a web page, that contains
hypertext links in order to navigate between the pages of a website. Since it usually appears on all
or at least on several pages of a website it is one of the key design-elements of websites.

NTSC is the analog television system in use in the United States, Canada, Japan, Mexico, the
Philippines, South Korea, Taiwan and some other countries, mostly in the Americas. It is named for
the National Television System Committee, the U.S. standardization body which adopted it.

«O»
Object in PicturesToExe is any image, file, frame, comment, text or button in the Object List.

OGG is an open standard for a free container format for digital multimedia, unrestricted by
software patents and designed for efficient streaming and manipulation. The name ‘Ogg’ refers to
the file format, which can multiplex a number of separate independent free and open source
codecs for audio, video, text (such as subtitles) and metadata. The term ‘Ogg’ is often used to refer
to Audio File Format OGG Vorbis, that is, Vorbis-encoded audio in the Ogg container.

Opacity is the state of being impenetrable to light. An opaque object is neither transparent
(allowing all light to pass through) nor translucent (allowing some light to pass through). When light
strikes an interface between two substances, some of the light is reflected, some is absorbed, and
the rest is transmitted.

«P»

PAL (Phase Alternating Line) is a colour encoding system used in broadcast television systems
in large parts of the world. Other common analog television systems are SECAM and NTSC. PAL
was developed by Walter Bruch at Telefunken in Germany. The format was first unveiled in 1963,
with the first broadcasts beginning in the United Kingdom and Germany in 1967.

PDF (Portable Document Format) is the file format, created by Adobe Systems in 1993 for
document exchange. PDF is fixed-layout document format used for representing two-dimensional
documents in a manner independent of the application software, hardware, and operating system.
Each PDF file encapsulates a complete description of a 2-D document (and with Acrobat 3-D,
embedded 3-D documents) that includes the text, fonts, images, and 2-D vector graphics, that
compose the document.

PNG (Portable Network Graphics) is a bitmapped image format, that employs lossless data
compression. PNG was created to improve upon and replace the GIF format, as an image-file
format not requiring a patent license. PNG supports palette-based (palettes of 24-bit RGB colors)
or greyscale or RGB images.

Preview may be where output of a particular document, page, film, etc. is displayed before it is
produced in its final form. In the case of printed material this is known as a print preview.

PTE is the abbreviation from PicturesToExe and is also the extension of projects, made in
PicturesToExe.

«R»

RGB is an additive colour model, in which red, green and blue light are added together in various
ways to reproduce a broad array of colours. The name of the model comes from the initials of the
three additive primary colours: red, green, and blue. The term RGBA is also used to mean Red,
Green, Blue, Alpha. This is not a different color model, but a representation; the Alpha is used for
transparency. The RGB colour model itself does not define what is meant by ‘red’, ‘green’ and
‘blue’ colorimetrically, and so the results of mixing them are not specified as exact, but relative.
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Rotate is to move about an object in a circular motion. A two-dimensional object rotates around a
center of rotation. A three-dimensional object rotates around a line called an axis. If the axis of
rotation is within the body, the body is said to rotate upon itself, or spin.

«S»

Screensaver is a type of computer program initially designed to prevent «Phosphor Burn-in» on
computer monitors by blanking the screen or filling it with moving images or patterns when the
computer is not in use. Today, screensavers are also used for entertainment or security purposes.

SECAM (Séquentiel couleur a mémoire, French for «Sequential Color with Memory»), is an
analog color television system first used in France. A team led by Henri de France, working at
Compagnie Francaise de Télévision (later bought by Thompson), invented SECAM. It is,
historically, the first European color television standard.

Slide in PicturesToExe is the image, which you use in the project and can see on the screen.
Slide List is the list of images, which you use in the project.

Slide show is a display of a series of chosen images, which is done for artistic or instructional
purposes. It is becoming more common to see digital slideshows. Slideshows custom made for
people using their photos, music, wedding invitations, birth announcements, or virtually any other
documents that can be scanned. Some people are calling these DVD's the new photo montage or
DVD slideshows.

SVCD disc (the Super Video CD) standard upgrades the Video-CD format. It utilizes better Video
and Audio quality. It also standard includes extensions for surround sound multi-channel audio,
provisions for PC playback. It's also based on variable bit rate (VBR) MPEG-2 coding for more
efficient use of disc capacity. The bit rate is up to 2.6 Mbps.

«T»

Template, when used in the context of file format refers to a common feature of many software
applications, that define a unique file format intended specifically for that particular application.
Template file formats are those, whose file extensions indicates, that the file type is intended as a
starting point from which to create other files.

Thumbnails are reduced-size versions of pictures, used to make it easier to scan and recognize
them, serving the same role for images as a normal text index does for words.

Timeline is the presentation of time of images and music and their synchronization.

TV System (analog television system) includes several components: a set of technical parameters
for the broadcast signal, a system for encoding color, and possibly a system for encoding multi-
channel audio. In digital television all of these elements are combined in a single digital
transmission system.

«V»

Video Codec is a device or software, that enables video compression and/or decompression for
digital video. The compression usually employs lossy data compression. Historically, video was
stored as an analog signal on magnetic tape. Around the time when the compact disc entered the
market as a digital-format replacement for analog audio, it became feasible to also begin storing
and using video in digital form, and a variety of such technologies began to emerge.

VCD (also called video CD, video compact disc or "disc") is a format specifically designed to hold
MPEG-1 video data and to include interactive capabilities. VCD has a resolution similar to that of
VHS, which is far short of the resolution of DVD format. Each VCD disc holds 72-74 minutes of
video and the bit rate is 1.44 Mbps. VCDs can be played on a VCD player connected to a
television set (in the same way that video cassettes can on a VCR) or computer, on a CD player.

«W»

WAV (or WAVE) is an audio file format standard for storing audio on computers. It is the main
format used on Windows systems for raw audio. Though a WAV file can hold compressed audio,
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the most common WAV format contains uncompressed audio in the pulse-code modulation PCM
format. PCM audio is the standard audio file format for CDs, containing two channels of 44,100
samples per second, 16 bits per sample. Since PCM uses an uncompressed, lossless storage
method, which keeps all the samples of an audio track, professional users or audio experts may
use the WAV format for maximum audio quality. WAV audio can also be edited and manipulated
with relative ease using software.

Waveform means the shape and form of a signal such as a wave moving in a solid, liquid or
gaseous medium. In many cases the medium in which the wave is being propagated does not
permit a direct visual image of the form. In these cases, the term «waveform» refers to the shape
of a graph of the varying quantity against time or distance.

WMV (Windows Media Video) is a compressed video file format for several proprietary codecs
developed by Microsoft. The original codec, known as WMV, was originally designed for Internet
streaming applications.

«Z»

ZIP is a file format, popular data compression and archival format. A ZIP file contains one or more
files that have been compressed, to reduce their file size, or stored as-is. The format was originally
designed by Phil Katz for PKZIP. However, many software utilties other than PKZIP itself are now
available to create, modify, or open (unzip, decompress) ZIP files.

Zoom is decreasing (narrowing) the apparent angle of view of a digital photographic or video
image. Digital zoom is accomplished by cropping an image down to a centered area with the same
aspect ratio as the original, and usually also interpolating the result back up to the pixel dimensions
of the original. It is accomplished electronically, without any adjustment of the camera's optics, and
no optical resoluton is gained in the process.

Most of the terms are taken from http://en.wikipedia.org.
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Tutorials and Articles

Please visit our web site:

http://www.wnsoft.com/apr/useful.htm

You can also have a look at unofficial User Manual:

http://www.wnsoft.com/apr/PicturesToExe_v50 UserManual_en.pdf
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Slide Shows Created in PicturesToExe

Please visit our web site:

http://www.wnsoft.com/download.htm
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Contacts

Our Web site:

http://www.wnsoft.com

You can find User Guide and unofficial User manuals on our website:

http://www.wnsoft.com/apr/help.htm
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